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Product Overview

® “What You Can Accomplish Using This Product” on page 1-2
e “Upgrading from an Earlier Release” on page 1-4
e “Required and Related Products” on page 1-5

¢ “Documentation and Demos” on page 1-6



1 Product Overview

What You Can Accomplish Using This Product
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Simulink® Design Optimization™ software is a Simulink®-based product that
lets you improve designs by estimating and optimizing model parameters
using numerical optimization. You can increase model accuracy by using
measured data to estimate parameters and then improve system performance
by automatically optimizing parameters in your Simulink model.

The software uses algorithms from the Optimization Toolbox™ and Genetic
Algorithm and Direct Search Toolbox™ products to estimate and optimize
model parameters. You can select multiple parameters for estimation and
optimization, and the parameters can be scalars, vectors, matrices or fields of
structured variables defined in the MATLAB® or model workspace.

You can perform the following types of estimation using the Simulink Design
Optimization software:

¢ Transient Estimation — Estimate parameters by comparing simulated
model output to measured transient data.

e Initial Condition Estimation — Estimate the initial conditions of states
from measured data.

e Adaptive Lookup Table Estimation— Estimate the lookup table values
using time-varying data from a physical system. The software provides
Adaptive Lookup Table blocks to model and estimate such types of systems.

Simulink Design Optimization software also lets you optimize model
parameters to meet time-domain design requirements. The software provides
a Signal Constraint block where you can graphically specify bounds on signals
or a reference signal to track. The software also provides CRMS and DRMS
blocks to compute the continuous and discrete root mean square values of
signals. Use these blocks with the Signal Constraint block to optimize the root
mean square value of the signal. You can also test and optimize the design for
robustness by specifying uncertainty bounds on additional model parameters.

When you have the Control System Toolbox™ software installed, you can also
refine controllers by optimizing the controller parameters in the SISO Design
Tool. You can perform optimization-based control design for LTI models and
Simulink models linearized using the Simulink® Control Design™ software.
You can graphically specify both time- and frequency-domain requirements



What You Can Accomplish Using This Product

on open- and closed-loop responses. When you use optimization-based control
design, the controller parameters can be poles, zeros, and gains or Simulink
block parameters.

You can work either in the Graphical User Interface (GUI) or at the command
line to estimate and optimize model parameters. New users should start by
using the GUI to become familiar with the product. The following operations
are available only using the GUI:

® Interactive data preprocessing (see “Data Analysis and Processing”)
® Model validation using residual plot (see “Comparing Residuals”)
® Optimization-based controller design for time- and frequency-domain

requirements (see “Optimization-Based Linear Compensator Design ”)

Using Simulink Design Optimization software does not require that you have
a strong background in optimization theory or practice. As you gain familiarity
with the product, you may find it helpful to consult the Optimization Toolbox

documentation to learn more about the optimization algorithms.
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1 Product Overview

Upgrading from an Earlier Release

Simulink Design Optimization software combines the functionality of
Simulink® Parameter Estimation™ and Simulink® Response Optimization™
products. Prior to R14, Simulink Response Optimization software was called
the Nonlinear Control Design Blockset software. Models that are created
using Nonlinear Control Design software will not work directly with Simulink
Design Optimization software. To convert your Nonlinear Control Design
Blockset models to work with Simulink Design Optimization software, use
the ncdupdate command, as described in Simulink Design Optimization
documentation.
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Required and Related Products

Required and Related Products

Simulink Design Optimization software requires MATLAB technical
computing software, Simulink software, and Optimization Toolbox software.

The following table summarizes MathWorks™ products that extend
and complement the Simulink Design Optimization software. For
current information about these and other MathWorks products, visit
http://www.mathworks.com/products/product_listing/index.htm]l.

Product

Description

Control System Toolbox

Design and analyze control systems.

Genetic Algorithm and Direct Search
Toolbox

Solve optimization problems using
genetic algorithms, simulated
annealing, and direct search.

Neural Network Toolbox™

Design and simulate neural
networks.

Parallel Computing Toolbox™

Perform parallel computations on
multicore computers and computer
clusters.

Simulink Control Design

Design and analyze control systems
in Simulink.

System Identification Toolbox™

Create linear and nonlinear dynamic
models from measured input-output
data.
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1 Product Overview

Documentation and Demos
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In this section...

“Accessing Documentation” on page 1-6

“Accessing Demos” on page 1-6

Accessing Documentation

The Simulink Design Optimization documentation contains the following
components:

® Getting Started Guide — Provides information for mapping your problem
to the capabilities of the Simulink Design Optimization software.
Step-by-step tutorials walk you through the most common tasks for
estimating parameters, optimizing parameters, and designing controllers
using optimization methods.

e User’s Guide — Describes tasks for using the Simulink Design Optimization
software.

¢ Reference — Describes commands and blocks for design optimization.

¢ Release Notes — Describes important changes in the current product
version and compatibility considerations.

If you are new to using this product, the Getting Started Guide helps you
begin using this product quickly. You can follow the steps in the tutorials to
perform design optimization using the graphical user interface (GUI) or the
MATLAB Command Window.

You can also search or browse the documentation for information about
specific design optimization tasks.

Accessing Demos

The Simulink Design Optimization software provides demo files that show
you how to estimate and optimize parameters of Simulink models, design
compensators using optimization methods, and model systems using Adaptive
Lookup Tables.



Documentation and Demos

To access demos in the Help browser, type the following command at the
MATLAB prompt:

demos

In the Demos pane, select Simulink > Simulink Design Optimization
to open the list of available demos.
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Estimating Model
Parameters

¢ “Types of Data for Parameter Estimation” on page 2-2
® “Quick Start — Estimating Model Parameters” on page 2-4

e “Parallel Computing for Parameter Estimation” on page 2-12




2 Estimating Model Parameters
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Types of Data for Parameter Estimation

You can estimate model parameters and initial conditions of single or
multiple input and output Simulink models from transient data. You measure
transient data when the system is not in steady-state to capture the system
dynamics expected under normal operating conditions. For example, the
response of a system to step or impulse inputs is transient data.

Simulink Design Optimization software lets you estimate model parameters
from the following types of data:

® Time-domain data — Data with one or more input variables u(t) and one or
more output variables y(¢), sampled as a function of time.

® Time-series data — Data stored in time-series objects. For more
information, see “Time Series Objects” in the MATLAB documentation.

When you import time-series data for parameter estimation, you must
specify the data and time vector as t.data and t.time, respectively. For more
information on how to import data into the GUI, see “Importing Data into
the GUI” in the Simulink Design Optimization User’s Guide.

Simulink Design Optimization does not directly support using complex data
for parameter estimation. Complex-valued data is data whose value is a
complex number. For example, a signal with the value 1+2j is complex. You
can use complex data when you want to estimate parameters of electrical
systems. For example, you can use complex data to estimate the magnitude
and phase of a system.

If you have complex data, use the MATLAB functions real, and imag to split
the data into two data sets that contain the real and imaginary values. You
can then import both data sets into the GUI, as described in “Importing
Data into the GUI” in the Simulink Design Optimization User’s Guide, and
estimate the parameters by specifying both data sets simultaneously as
estimation data.

Note You must sample the real and imaginary parts of the data as a function
of the same time vector.




Types of Data for Parameter Estimation

Simulink Design Optimization software estimates model parameters by
comparing the transient data with simulation data generated from the
Simulink model. Using optimization techniques, the software estimates the
parameters and initial conditions of states to minimize a user-selected cost
function. The cost function typically calculates a least-square error between
the measured and simulated data. To learn more, see “Estimating Model
Parameters” in the Simulink Design Optimization User’s Guide.
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2 Estimating Model Parameters

Quick Start — Estimating Model Parameters

In this quick start, you get an overview of the typical tasks for estimating
model parameters using the Control and Estimation Tools Manager GUI:

1 Start a parameter estimation task.

2 Import estimation and validation data sets.

3 Select parameters to estimate.

4 Estimate the parameters from the estimation data.

5 Validate the estimated parameters using the validation data set.
Prerequisites for parameter estimation include:

¢ Simulink model that contains inport or outport blocks, or signal logging

For more information, see “Configuring a Model for Importing Data ” in the
Simulink Design Optimization User’s Guide.

® Transient data in the MATLAB workspace
To estimate model parameters:

1 Start a parameter estimation task by selecting Tools > Parameter
Estimation in the Simulink model window.
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Quick Start — Estimating Model Parameters

New
estimation
task

5] control and Estimation Tools Manager =0 x|
File View Hzlp
S0 ad|
@\ Workspace |- Task settings
=1 W Project - spe_engine_t || Tige: I
-
Transient Data || Subject: |
Variables .
Author:
Estimation I .Optlonall
g validation Company: | 4 information
about the
Description: | estimation task
[
Madel: spe_engine_throttlel Open Madel Update Task |
J |
=]
=
Select the nodes below ko configure and run estimations. v
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2 Estimating Model Parameters

2 Import the input and output data for estimating and validating model
parameters.

a Select the Transient Data node, and click New.

b Select the New Data node.

¢ In the Input Data tab, select the Data cell corresponding to the model

channel, and click Import. Select the variable to import in the Data
Import dialog box.

Model channe
for which you
import data

E! Control and Estimation Tools Marager

File view Help

Select and
click Import
to import data

Select and
click Import to

import time vector

Select variable
to import

=il = e

zl

4:\ Workspace
=] G Praject - spe_enginz_t
-l Estimation Task
= Transient Data
H 41| Mew Data

Variables
Estimation

Ea Validation

4 ]

Input D363 | output D
~Assign fata to blocks

3 | State Data|

Impoft from: |K

Bladk Mame | Data I Time | T | Weight I Length varigale Namel Size | Bytes I Clase
spe_engine_throtye 1input @J 141 o dounial
Channel - 1 ‘ 1 | /- =

FER Kt 131 & doufh

P andle it 1x1 3 doupn ™

i+ Assign the following columns to selected chanr

i~ Assign the following roms to selected channel(:
i Import,.. I Pre-proces... Plok Data Clear all |

- New Data nods has been added ko Transient Data,

Select the tabbed panels ko configure the transient data set.

Impart | Close | Help |

7|

Import variable

d Select the Time /T's cell, and click Import. Select the time vector to

import in the Data Import dialog box.

e In the Output Data tab, repeat steps c—d to import the output data
and time vector.
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Quick Start — Estimating Model Parameters

f Repeat steps a—d to import the validation data set.

=] Control and Estimation Tools Manager

Validation
data node

File Wiew Help

=0l x|

g0 d|

ﬂ ‘Workspace
EG Project - spe_engine_throk
EI-- Estimation Task
- Transient Data
] New Data
fNew Dak
L Variables
. Estimation

Ea Validation

Kl | H

Input Data | Qutput Data | State Data |

—MAssign data to blocks
Block Mame I I Time | Ts | ‘Weight | Length
spe_engine_throttle1/nput
Channel - 1 | 1 | -/
Impatt. .. Pre-proces. .. Blok Data Clear all I

Select the tabbed panels to configure the transient data set.

- New Data node has been added to Transient Data.
- New Data (2) node has been added to Transient Data.

NI

For more information, see “Importing Data into the GUI” in the Simulink
Design Optimization User’s Guide.

3 Specify parameters to estimate by selecting the Variables node, and

clicking Add. Select the parameters in the Select Parameters dialog box.

E]Contml and Estimation Tools Manager -

File View Help

=loi x|

Select
parameters
to estimate

= =
S olca=
(A Workspace Estimated Parameters | Estimated States |
B EI]EEt' spe_engine_thr | Selecked parameter -Default setting
[=-Z1] Estimation Task .
G ;I Name:
Value:
i : Initial guess:
% Estimation T
g validation Maximum:
Typical value:
=
Referenced by:
< | H [}

I'Nl_tﬂ'— [Ew Data (2] node has been added fo Transieft Data.
Select the tab panels ta configure your estimation parameters and states.

=] select Parameters x|
rSelect additional paramgters ko estimate
Name ‘ Size
3 1x1 =
Kt 1x1
angle_init Tl
angle_open Tl
c 1x1
input_dslay Tl
k 1x1
|
Specify expression (2.g., 5.x, a(3), b{2}):
Ok | Cancel Help | Apply |

A

Specify parameters
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2 Estimating Model Parameters
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For more information, see “Specifying Parameters to Estimate” in the
Simulink Design Optimization User’s Guide.

4 Estimate the parameters.

a Select the Estimation node, and click New.

b Select the New Estimation node.

¢ In the Data Sets tab, select the estimation data set.

Lists imported
data sets

Select data set
for estimation

=] Control and Estimation Tools Manager

=10l
File View Help
o
D8 d
g\ Workspace Data Sets | parameters | States | Estimation |
E“ Project - spe_engine_throtl | _pata sets used For estimation ~Output data weights
E}-- Estimation Task - — -
: Transient Data ITransnant estimation LI Block Name I Length I Weight
New Data = e spe_engine_throttle 1/Position
1] New Data (2) - 322 Secte Channel -1 | -I- [ 1
Variables LEnEEE —
Estimation New Data (2) r
B New Estimation I =
Ea Views
i#l- (g validation Select Al Claral |
| | &
- New Estimation node has been added to Estimation, ;I
5
Select the tab panels to configure your estimation. v




Quick Start — Estimating Model Parameters

d In the Parameters tab, select the parameters to estimate.

Keep parameters

fixed or estimate

(Optional) Specify

initial parameter value

(Optional) Specify
parameter bounds

=] Control and Estimation Tools Manager 1Ol =l

Fil= WView Help
=Rall=0= N

ﬂ Warkspace Data Sets  Parameters I Statesl Estimationl
Elﬂ Project - spe_engine_throtl

o ~Estimation parameters Y ¥
=3 Estimation Task ! — — - -
-7 Transient Data Mame Value Estimate Initial Guess Minimum Mazximurm Typit
4] New Data 3 0.05 [ il -Inf +Inf
] New Data (2) c 40 ¥ [ -Inf +Inf
Variables input_delay 0.02 = input_delay -Inf +Inf inpL

Estimation

E% MNew Estimation Pl |
Views
Ea Validation Use Value as Initial Guess Reset ko Default Settings Save as Default Settings |

| |

- Mew Estimation node has been added to Estimation.

=l
=
2

Select the tab panels to configure yvour estimation.

e In the Estimation tab, begin estimation by clicking Start.

Infomration about
convergence of the
estimation algorithm

L=] Control and ation Tools Manage -1o] x|
File View Help
&0 g a|E
4)« Warkspacs Data Sets | Parameters | States Estimation
W Project - spe_engine_thrott | —ESimeton progres
3] Estimation Task
8 Iteration |;unctlun ... | CostFun...| StepSize | Procedure Estimation Options. .. |
45 50 27723 l646.65 =
50 st 2766.6 115.67 Display Options. . |
% Variables 51 52 2766.6 167.67
= Estimation 52 53 27658 146,918
53 54 2765.8 70,879 Sta.rt .
54 55 27656 [17.72 Start |" r— estimation
55 s weEE  [oroH I Select to
56 57 2765.6 /6.9335 ||| T show progress view
Performing transient estimation... = meas!'"Ed
Active experiments: Dataset] and Slmmatle?
Estimated parameters: I, c, input_delay, k response plots
Optimization terminated: relative function value Estimation
changing by less than OPTIONS. TolFun, report
4 |
7 [—|
I~
Seleck the tab panels to configure your estimation, //A




2 Estimating Model Parameters

f In the Parameters tab, examine the estimated parameter values. The
Simulink model also gets updated with the estimated parameter values.

Estimated
parameter values

=] Control and Estimation Tools Manager -0l =|

File View Help

=
gdhca|
ﬂ Workspace Data Sets Parameters I Statesl Estimationl
B _“J Project - sp=_endrr | —Ectimation parameters
=3 Estimation Task
iﬁ; Transient C Mame Valus Estimate Initial Guess Minimum Maximum | Typical Vah
[ Variables i 0.22364 v il 0 +Inf i
Estimation | || |< 9.0575 v 3 [ +Inf c
E% NewEs || [input_delay 0.0089359 v input_delay 0 0.1 input_dela
-0 views k 19.89 v k [ +Inf k
Ll New
Ea Validation
| =n
Use Value as Initial Guess Reset to Default Settings Save as Default Sethings |
d| | W

IEst\mation complzted.

Select the tab panels to configure your estimation,

s L

For more information, see “Performing Estimation” in the Simulink Design
Optimization User’s Guide.

5 Validate the estimated parameters.
a Select the Validation node, and click New.
b Select the New Validation node.
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Quick Start — Estimating Model Parameters

¢ Configure the validation plots and the validation data set.

Select validation

plot type

Select validation

data set
=] control and Estimation Tools Manager

=lalx|
File View Help
&G0 S d|E
@ ‘Workspace Validation Setup |
Eﬂ Project - spe_sngine_thr —Select plak types
=) Estimation Task -
7] Transient Data Plok Number Flat Type Flok: Title
MNew Data Plok 1 Residuals d
Mew Data (2 Plat 2 (nonezl
I3 Variables Plat 3 (none:| LI
Estimation Flot 4 (none
B New Estimati | ot
ptions
E--Ea Views o
Tl New View Validation data set:
g validation
= Ea e Estimation Plat 1
@ Mew Validatic
MNew Estimation [m]
Show Plats

1 I H __I

Configure validation plots.

s L

Select to
display
validation plot

Opens
validation plots

For more information, see “Performing Validation” in the Simulink
Design Optimization User’s Guide.

See Also: Chapter 6, “Tutorial — Estimating Parameters from Measured
Data Using the GUI”

2-11



2 Estimating Model Parameters
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Parallel Computing for Parameter Estimation

When you have the Parallel Computing Toolbox software, you can use
parallel computing to speed up parameter estimation. When you use parallel
computing, the software distributes the independent simulations on multiple
MATLAB sessions. Thus, the simulations run in parallel which reduces the
estimation time.

Using parallel computing may reduce the estimation time in the following
cases:

® The model contains a large number parameters to estimate, and the
Gradient descent or Nonlinear least squares algorithm is selected as
the estimation algorithm.

e The Pattern search algorithm is selected as the estimation algorithm.
® The model is complex and takes a long time to simulate.

For more information, see “Speeding Up Parameter Estimation Using Parallel
Computing” in the Simulink Design Optimization User’s Guide.



Optimizing Model
Parameters

® “Types of Time-Domain Design Requirements for Optimizing Parameters”
on page 3-2

® “Quick Start — Optimizing Model Parameters” on page 3-3

® “Parallel Computing for Parameter Optimization” on page 3-11



3 Optimizing Model Parameters

Types of Time-Domain Design Requirements for Optimizing
Parameters
You can optimize parameters of Simulink models to meet the following types
of time-domain design requirements:
® Step-response characteristics such as overshoot, and rise time.
® Lower and upper bounds on signals
® Reference signal
Simulink Design Optimization software optimizes the model parameters by
formulating the time-domain requirements into a constrained optimization
problem. It then solves the problem using optimization algorithms. During
the optimization, the software performs the following operations:
* Simulates the Simulink model,

® Compares the simulation data with the constraint objectives and any
specified reference signal

e Uses gradient methods to modify selected model parameters to meet the
objectives

To learn more, see “Optimizing Model Parameters” in the Simulink Design
Optimization User’s Guide.
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Quick Start — Optimizing Model Parameters

Quick Start — Optimizing Model Parameters

In this quick start, you get an overview of the typical tasks for optimizing
model parameters to meet time-domain requirements:

1 Specify an input signal in the Simulink system.

2 Specify the design requirements.

3 Specify parameters to optimize.

4 Optimize the parameters.

5 Evaluate the optimization results.

Prerequisites for optimizing model parameters include:

e Simulink model

¢ Time-domain design requirements
To optimize model parameters:

1 In the Simulink model, specify an input signal to the system. For example,
add a Step block.

-ipix
File Edit View Simulation Format Tools Help
D|EE& & @4 (= r =k [iom Ea (g2

Cut?

¥

FID

Unit Step

Controller Flant

Ready [100% [ [ |ode45 v

2 Specify the time-domain design requirements:
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3 Optimizing Model Parameters

a In the Simulink Library Browser, select Simulink Design
Optimization.

b Drag and drop the Signal Constraint block into the model.

¢ Connect the Signal Constraint block to the signal that should meet the
design requirements.

=T
File Edit View Simulation Format Tools Help
DEeES| 2R8> 4|22 » =ko  [m =R RE R
“ PID ! int Out
Unit Step -
Contraller Flant
Signal Constraint

Ready 100% |ode4s v
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Quick Start — Optimizing Model Parameters

d Double-click the Signal Constraint block.

Design requirements appear as line segments in the Block Parameters:
Signal Constraint block window. By default, the design requirements
are step-response characteristics.

) Block Parameters: Signal Constraint =101

File Edt Plots Goals Optimization Help
Sdeaag|r =

InpLt to sldo_modell _constrblkrSignal Constraint

(u:]

06

Amplitude

) R :

)7 |

02
o £l 10 15 20 25 30 35 40 45 50
Time (sec)
[V Enforce signal bounds [~ Track reference signal
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3 Optimizing Model Parameters

e Double-click the lower yellow region on the plot. Specify the design

requirements in the Edit Design Requirement dialog box.

J Edit Design Requirement — =] ]

4 Select design

requirement
type

Enter design

Design reguirement: Ianer time response bound from 0to 50 sec LI

~Design requirement parameters

Segments:
Skart End

Time Amplitude Time Amplitude Slope Weight
0 -0.0100 5 -0.0100 0 1|
5 0.9000 15 0.9000
15 0,9900 S0 0,9900

requirement
values

For more information, see “Specifying Design Requirements” in the
Simulink Design Optimization User’s Guide.



Quick Start — Optimizing Model Parameters

3 In the Block Parameters window, select Optimization > Tuned
Parameters, and click Add. Select the parameters to optimize in the
Add Parameters dialog box.

Lists parameters

selected for optimization Select
parameters
) Tuned Parameters =18
_'Ei:’nad parametersi;l —:)::::izaﬁnn Setting o ;Iglil
kp alue: 1 Select workspace variables:
Initisl guess: }(p EI‘" ;I
Minimim; E Kp
Ifzimum: 'nf ;Ve?a
Typical value: }(p
¥ Tuned
Referenced by:
Controller LI
Specify expression (e.g., s.x or al3]);
|
[
ﬂ_l Delete | OK I Cancel I Help I

OK I Cancel Help I

Specify parameters
to optimize

For more information, see “Specifying Parameters to Optimize” in the
Simulink Design Optimization User’s Guide.

4 In the Block Parameters window, start the optimization by selecting
Optimization > Start.

The Optimization Progress window opens where you see the optimization
progress.
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3 Optimizing Model Parameters

Optimization Progress

For more information, see “Running the Optimization” in the Simulink
Design Optimization User’s Guide.



Quick Start — Optimizing Model Parameters

5 Evaluate the optimization results after the optimization completes.

a In the Block Parameters window, compare the response of the system
against the design requirements.

) Block Parameters: Signal Constraint =10/ x|

File Edit Plots Goals Optimization Help

Sde| R B|r =&

Input to optimn_madel /Signal Constraint

Optimized
response
shown in
black

Amplituds

-02
a 5 10 15 20 25 30 35 40 43 a0

Time [zec)
[V Enforce signal bounds [~ Track reference signal

Initial
response
shown in
blue
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b In the Optimization Progress window, view the optimized parameter

values.

) Optimization Progress (=] 3]
e

Iter

. . . a
Optimization _, 1
report z
3

4

£ (x)
0
]
0

-£.15412=-020
o

Fuccessful termination.
Found a fesasible or optimal solution within the specified tolerances.

-1
max Directional First-order
constraint Step-size derivative optimality Procedure

207.1

3.787 1.25 [u] 1 infeasible

0.4841 0.541 [u} &.18

0.02942 0.0755 =il elei=—{n Al 0.000881

o 0.0233 3-05e_Ri1E 0.000114 Hessian modifi=d

Zc
]

Optimized ——f* =
parameter values 5
=

]

-04e8

calish

.1853

<

See Also: Chapter 7,

“Tutorial — Optimizing Parameters to Meet
Time-Domain Requirements Using the GUI”.



Parallel Computing for Parameter Optimization

Parallel Computing for Parameter Optimization

When you have the Parallel Computing Toolbox software, you can use parallel
computing to speed up optimizing model parameters to meet time-domain
design requirements. When you use parallel computing, the software
distributes the independent simulations on multiple MATLAB sessions. Thus,
the simulations run in parallel which reduces the optimization time.

Using parallel computing may reduce the optimization time in the following
cases:

® The model contains a large number of parameters to optimize, and the
Gradient descent algorithm is selected for optimization.
e ThePattern search algorithm is selected for optimization.

® The model contains a large number of uncertain parameters and uncertain
parameter values.

® The model is complex and takes a long time to simulate.

For more information, see “Speeding Up Response Optimization Using
Parallel Computing” in the Simulink Design Optimization User’s Guide.

3-11



3 Optimizing Model Parameters

3-12



Optimization-Based Linear
Control Design

* “When to Use Optimization-Based Linear Control Design” on page 4-2
® “Types of Time- and Frequency-Domain Design Requirements” on page 4-3

® “Quick Start — Optimization-Based Linear Control Design” on page 4-4



4 Optimization-Based Linear Control Design
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When to Use Optimization-Based Linear Control Design

When you have Control System Toolbox software installed, you can design
and optimize control systems for LTI models by optimizing controller
parameters in the SISO Design Tool. To use optimization methods for linear
control design, also known as optimization-based tuning, you must already
have an initial controller. You can then use optimization-based tuning to
refine the controller design to meet additional design requirements. For
more information on designing controllers, see the Control System Toolbox
documentation.

Note Optimization-based tuning only changes the value of the controller
parameters and not the controller structure itself.

Optimization-based tuning provides flexibility in terms of specifying
additional design requirements for the controller. When you have a large
number of design requirements, you can first design an initial controller
by selecting a subset of requirements and subsequently select additional
requirements to refine the design.

Optimization-based tuning also provides flexibility in terms of selecting a
subset of controller parameters to optimize, and specifying bounds on the
controller parameters.

To design linear controllers for Simulink models using optimization-based
tuning, you must first linearize the model using the Simulink Control Design
software. For more information on linearizing Simulink models, see the
Simulink Control Design documentation.



Types of Time- and Frequency-Domain Design Requirements

Types of Time- and Frequency-Domain Design
Requirements

When you design linear controllers for LTI or Simulink models using the
Simulink Design Optimization software, you can specify both time- and
frequency-domain requirements on the system response. You can specify
design requirements on the following plots:

Root Locus plot
¢ Open-Loop and Prefilter Bode plots
® Open-Loop Nichols plot

Step/Impulse Response plots

For more information, see “Supported Time- and Frequency-Domain
Requirements” in the Simulink Design Optimization User’s Guide.

Simulink Design Optimization software uses the frequency-domain
requirements to compute the frequency response of the system. It then uses
optimization algorithms to reduce the distance between the current response
and the requirements by modifying the controller parameters. The software
does not change the controller structure when optimizing the controller
parameters. To learn more, see “Optimization-Based Linear Compensator
Design ” in the Simulink Design Optimization User’s Guide.
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4 Optimization-Based Linear Control Design

Quick Start — Optimization-Based Linear Control Design

In this quick start, you get an overview of the typical tasks for
optimization-based linear control design using the SISO Design Tool:

1 Open a SISO Design Tool session.

2 Configure a project for optimization-based control design.
3 Specify the controller parameters to design.

4 Specify the design requirements.

5 Design the controller.

6 Evaluate the controller design.

Note The same workflow applies to optimization-based control design for LTI
models created at the command line using Control System Toolbox software.
To learn how to create LTI models, see “Linear (LTI) Models” in the Control
System Toolbox documentation.

Prerequisites for optimization-based linear control design include:
¢ Simulink Compensator Design Task that contains a linearized version of
the Simulink model and, optionally, any response plots you configure.

For more information on how to linearize a Simulink model for control
design, see “Designing Compensators” in the Simulink Control Design
documentation.

¢ Time- and frequency-domain design requirements

To design a controller using optimization methods:



Quick Start — Optimization-Based Linear Control Design

1 Open a SISO Design Tool session by typing the following command at the

MATLAB prompt:

sisotool(’projectname.mat’)

] Control and Estimation Tools Manager P[] 3}
File Help
ERRER:
1:\ Workspace Project Setting:
E‘m OperatinPoints Title: IPrU]ect - sldo_model2
g
SISO Design Task & 1] imul Compensator De || ¢ i |
for SISO Design —_— j SIS0 Design Task
Tool Created by: I
Date modified: 10-Nov-2008
Simulink model:  sldo_madel2
Description: ;I
| am [
2
i
Project node. v

The command also opens a SISO Design for SISO Design Task window by
default and any response plots you configured when you linearized the
Simulink model using Simulink Control Design software.
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4 Optimization-Based Linear Control Design

2 Configure a project for optimization-based control design by clicking

Optimize Compensators in the Automated Tuning tab of the SISO
Design Task.

) Control and Estimation Tools Manager

File Edit Tools Help

o [m] P4
el N
41 Workspace .ﬂrchltectural Compensator Ed\tarl Graphical Tuning | Analysis Plots Automated Tuning
- Praject - sldo_modsl2

K —

) Gperating Points Design methad:  [Optimization Based Tuning
=1l simulink Compensator De
3

~|
o

(- Optimization Based Tuning

‘fou can use optimization-based tuning ko create an initial compensator design or to refine the current compensatar
design:

Graphically spacify design requirements Far your system by positioning bounds on design or analysis plots such as
Bade, Nichols, or Step Response. Then, use aptimization-based methods to automatically tune compensator elements
to satisfy the design requirements, Compensator elements that are tunable via optimization-based tuning includs
gains, poles, and zeros.

Requires the Simulink Design Optimization product,

Optimize Compensators,

LI Store Design Update Simulink Block Paramaters

™ Automatically update black parameters Help

SISO Design Task Mode,

s L LI

Method for
controller
design



Quick Start — Optimization-Based Linear Control Design

This action creates a new Response Optimization node in the Control
and Estimation Tools Manager.

=] Control and Estimation Tools Manager o =] 3}
Fie Edi Tools Help

S0 Ed|9 ™

[ workspace Overvien | Compensatars | Design requirements | Optimization
£ T8 Project - sida_madel2 e
Operating Points
(=13 Simulink Compensator Design
1% SIS0 Design Task | |
[[7) Design History 1 I
i Step 1 1 Step 2 I Step 3
1 1
1 1
! Set optimization I
: options :
1 1
Selact 1 1
EOMpensators lo 1 1
optimize 1 1
1 1
1 1
1 1
Optimize + View results
1 1
1 1
1 1
Select design 1 1
requirements : :
1 1
1 1
1 1
_4|—| LI Start Optimization Llpl

Response Optimization

s L Ll
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4-8

3 Specify the controller parameters to design in the Compensators tab.

Right-click to change
Select parameters controller parameters

block mask parameters

Optional) Specif
to optimize representation to Simulink i(nitKi)aI vallze pecty

(Optional) Specify
parameter bounds

=] Control and ation Too g -0l x|
File Edit Tools Help
o i = B
i_:\ Warkspace Overvigm Compensatars | Design requiremgnts | Optimization |
E‘“ Project - sldo_madelZ | gajact ompensator elements to optimize
[+ Operating Paoinks
E1-E] simulink Compens I~ Optimize Compensator elements | Value | Initial guess | Minimum Maximum Typical value
E‘EJ 5150 Design ° - sldo_miodel2/Controller
Design Hi O Gain 0.1 0.1 -Inf Inf 0.1
Design Q| O Real Zero -8.999 -8,999 -Inf Inf -5.,999
frespons - Real Zero -0.10102 -0.10102 -Inf Inf -0.10102
i Real Pale -100 -100 -Inf Inf -100
Right click on a corpensator name to changa its representation.
Use Walue as Initial Guess |
‘I I _’I Skark Opkimization | Help |

Response Optimization

4
=
4

B




Quick Start — Optimization-Based Linear Control Design

4 Specify the design requirements.

a Inthe Design requirements tab, click Add new design requirement.
Specify the design requirements, for example Bode magnitude lower
limit, in the New Design Requirement dialog box.

L] Control and Estimation Tooks Hanager

ioi il

T I E

NallE] W .

30 o = Design requirement typs: Requlrement
[ sbions | vervien| Compemators Destn recurements | otimintion| type

Moo o pedec R = Far response:

3 - ! ... Loop from Uit Step to Controler v | 4e . Response

o4 Gl sk compensni e I opter | Pesperce p: type

=) 5160 Detin Ttk »
5 ) oson Moty Design requirement parameter
Eﬁn-vmrb«rmm egments:
) Start End
Frequency | Magnitude | Freauency [ Magniude | Sipe | weight | [Le— REQUirement
il 0 0] U of 1 values
Insert Delete
oK Cancel | Help
Chkhe -
requirement

I =S| N
Response Cptmzation o
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4 Optimization-Based Linear Control Design

In the SISO Design window, the yellow region with the black line
segment represents the design requirement on the response plot.

) SISO Design for SISO Design Task 10| =l

File Edit View Designs Analysis Tools Window Help a
« o = o
X0 ¥ & S R KT8

Open-Loop Bode Editar for Open Loogp 1 (L1)
50 T T T T T T

Magnitude [dB)
n
o

-100
GM.Inf

Freq: Inf
Stable loop

-150
-45 T T T T T T

Phase (deq)

-135

P804 degy

Fred: 0505 radizec
= YO0 NP YY DY SN YU U OTY P 0T SRR My = = =
107 107 107" 10" 10" 10° 107 10}

Freguency (radfzec)

Right-click on the plots for more design options.
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Quick Start — Optimization-Based Linear Control Design

The Design Requirements tab also lists the design requirement.

Select the requirement
to enforce during

ST Lists all specified
optimization design requirements
=] control and Estimation Tools Manager =1ol x|
File Edit Tools Help
o
SO Ed|2
i_\ Workspace Qvervi wl Compensators Design requirements | Opt\mization'
B “ Project - sido_model2 - Select|design requirements to satisFy
[ Operating Poinks
é Simulink Compensator De [~ Optimize Respaonse plat I Design requirement
= ﬂ SISO Design Task - Open Loop at outport 1 of Controller
7| Design History = Open-Loop Bode Editor For Open Loop 1 (L1) | Lower gain limit from 0,001 to 1 rad/sec
B Design Operating
B ‘_'] Response Optimi

Click the 'Add new design requirement’ button or right click an a plot to add a new design requirement.

Show Plats | | i Add new design requirement. ., |

[H— b

Start Optimization | Help |

Unda

y L LD

b Repeat step a to specify additional time- and frequency-domain
requirements.
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5 Start the optimization to design the controller by clicking Start

Optimization in the Optimization tab.

7] Control and Estimation Tools Manager

=101 %]
File Edit Tools Help
dOed|2 «
4_:\ Workspace Qverview Compensatorsl Design requiremants  Optimization |
= Wgh Proiect - sldo_madel2 ~Dptmization progr
Operating Points
=] Simulink Compensatar ITteration Eval-Count |Cost function|Constraint... | Step size Procedure Optimization options. .. |
£ 5150 Design Task a 7 0 57.12 N
(3 Desin Histo 1 14 [] 1777 8.36 Display options... |
Design Opera 2 21 ] 1.697 12.1 Hessianm...
- #) Respanse Opl 3 28 o o 217
Constructing optimization prablem... =

Optimization started 10-Nov-2008 14:01:11
Optimization finished 10-Nov-2002 14:01:21

Successful termination. Found = feasible or optimal solution within the specified
tolerances.

i Start Optimization | Help |

Redo

s L ]

Optimization
progress

Optimization
status



Quick Start — Optimization-Based Linear Control Design

6 Evaluate the controller design.

a Examine the system’s response in the response plot, for example the
Bode plot, to see if it meets the requirements. The system’s response
must lie in the white region in order to meet the design requirement.

) SISO Design for SISO Design Task

File Edit View Designs Analysis Tools Window Help

=0l x|

Ll

BEEXEEERYEEL

Open-Loop Bode Editor for Open Loop 1 (L1)

40 T

Magnitude (dE)

G Inf
80| Freo Inf
Stable loop

Recuirement; 7
Pl = BD_

100 ARt

-80 y T

-135

FPhaze (deg)

P 861 deg
Freo 2.79 radizec

B0 e

Y S YR TY SNy P ET) [ P TS A R A RTY S

i 107 1™ 10" 10"

Freqguency (radisec)

100

107 10

Undoing Optithize compensatars.
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4 Optimization-Based Linear Control Design

b Examine the controller parameter values in the Compensator tab.

Optimized controller
parameter values

=] Control and Estimation Tools Manager 100 x|
File Edt Tools Help

g0 EW|9 o

ﬂ Workspace Overview Compensators | Design requiremants | Optimization |

£1- g Project - sido_model2 [ Select compensatar elements ko optimi
% Operating Points

=52 simulink Compensator De [~ Optimize Compensatar elements | Walue |Imtia\ guessl Minimum | Maximum I Typical ¥...
=] :J SISO Design Task [m] sldo_model2/Controller
() Design Histary I F 6.7627 1 -Inf Inf 1
t b Design Operating v 1 3.4445 0.1 -Inf Inf 1
- %) Respanss Optimi [ D 11.106 0.1 -Inf nf 1
O N 100 100 -Inf Inf 1

Right dick on 3 compensatar name ta change its representation.

4 | _;I i Skart Optimization Help

Use Value as Initial Guess I

o L Lo

7 Write the controller parameter values into the Simulink model. To do so,

click Update Simulink Block Parameters in the SISO Design Task
node.

See Also: Chapter 9, “Tutorial — Designing a PID Controller Using
Optimization-Based Tuning”.
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Tutorial — Preparing Data
for Parameter Estimation

Using the GUI

e “About This Tutorial” on page 5-2

e “Configuring a Project for Parameter Estimation” on page 5-4
¢ “Importing Data into the GUI” on page 5-6

® “Analyzing Data” on page 5-14

e “Selecting Data for Estimation” on page 5-16

* “Removing Outliers” on page 5-25

e “Filtering Data” on page 5-29

* “Interpolating Missing Data” on page 5-34

® “Saving the Project” on page 5-37



5 tutorial — Preparing Data for Parameter Estimation Using the GUI

About This Tutorial

In this section...

“Objectives” on page 5-2

“About the Sample Data” on page 5-2

Obijectives

In this tutorial, you learn how to import, analyze, and prepare measured
input and output (I/0) data for estimating parameters of a Simulink model.

Note Simulink Design Optimization software estimates parameters from
real, time-domain data only.

You learn to perform the following tasks using the GUI:

¢ Import data from the MATLAB workspace.
¢ Analyze data quality using a time plot.

¢ Select a subset of data for estimation.

®* Remove outliers.

¢ Filter high-frequency noise.

¢ Compute missing data using interpolation.

About the Sample Data

In this tutorial, you use spe_engine_throttleil.mat, which contains I/O
data measured from an engine throttle system. The MAT-file includes the
following variables:

e input1 — Input data samples

® position1 — Output data samples

e time1 — Time vector



About This Tutorial

Note The number of input and output data samples must be equal to the
length of the corresponding time vector.

The engine throttle system controls the flow of air and fuel mixture to the
engine cylinders. The throttle body contains a butterfly valve which opens
when a driver presses the accelerator pedal. Opening this valve increases the
amount of fuel mixture entering the cylinders, which increases the engine
speed. A DC motor controls the opening angle of the butterfly valve in the
throttle system. The input to the throttle system is the motor current (in
amperes), and the output is the angular position of the butterfly valve (in
degrees).

spe_engine_throttlel.mdl contains the Simulink model of the engine

throttle system. For more information on building models, see “Creating a
Simulink Model” in the Simulink documentation.
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Configuring a Project for Parameter Estimation

To perform parameter estimation, you must first configure a Control and
Estimation Tools Manager project.

1 Open the engine throttle system model by typing the following at the
MATLAB prompt:

spe_engine_throttlel

This command opens the Simulink model, and loads the data into the
MATLAB workspace.

10
File Edit Yiew Simulation Format Tools Help
D|@n§|%ﬁ|@=§?|9c2|} IID.5 INormaI j|@
Engine Throttle Model
Copyright () 2002-2004 The Mathworks, Inc.

CO—y o »

nput Throttl

rottle

Motor 3 Position

Throttle .(D

Fosition
Ready [122%% [ [ |ode4s >

Simulink® Model of Engine Throttle System
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Configuring a Project for Parameter Estimation

2 In the Simulink model window, select Tools > Parameter Estimation.

This action opens a new project named Project - spe_engine_throttlel in

the Control and Estimation Tools Manager GUI. This project contains the
Estimation Task, as shown in the next figure.

E! Control and Estimation Tools Manager

File Wiew Help

=10l x|
B D |2 |3
ﬂ Workspace ~Task setting
= T Project - spe_engine_throttel Title: I
imation Task
Transient Data Subject: I
Wariables author: I
1 a Estimation
Ea Walidation Company': I
Description: ﬂ
[l
Model: spe_engine_throttlel Open Maodel Update Task |
4
=
Select the nodes below ko configure and run estimations. v
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Importing Data into the GUI

In this section...

“Importing Input Data and Time Vector” on page 5-6

“Importing Output Data and Time Vector” on page 5-11

Importing Input Data and Time Vector

In this portion of the tutorial, you import measured I/O data into the Control
and Estimation Tools Manager GUI. Importing data assigns the data to the
corresponding model input and output signals.

The model input and output signals are designated with the Inport Input
and Outport Position blocks respectively, as shown in the figure Simulink®
Model of Engine Throttle System on page 5-4. These blocks let you import I/0
data into the GUI. To learn more about the blocks, see the Inport and Outport
block reference pages in the Simulink documentation.

You must have already configured the parameter estimation project, as
described in “Configuring a Project for Parameter Estimation” on page 5-4.

To import input data and time vector into the Control and Estimation Tools
Manager GUI:



Importing Data into the GUI

1 In the Control and Estimation Tools Manger GUI, select Transient Data
under the Estimation Task node, and click New.

This action creates a New Data node under the Transient Data node.

L) control and Estimation Tools Manager

=10l
File Wiew Help
ok O [ & [[E
Q« Wiorkspace rTransient data set
= W9 Project - spe_engine_thrott Name I Properties I
ER=! Mews Data ;I
]
Drescription:
=
[
THewH Delets Edit...
| | B
- New Data node has been added to Transient Data. ﬂ
=
Transient data sets are skored in this folder. Press Mew' to create a new data set v
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2 Select the New Data node.

E! Control and Estimation Tools Manager o =] 5|
File Wiew Help
e D= 3|
. workspace Input Data | Qutput Data | State Data |
= W Project - spe_engine_throtth ~Assign data to blacks
-] Estimation Task - -
= iﬁ Transient Data Block Mame | Data | Time | Ts | ‘Weight Length
BHF= a spe_engine_throttle1input
L Yariables Channel - 1 ‘ | 1 -
Estimation
Ea Walidation
Impart... Pre-process... Flot Data Clear Al |
d | 3
— New Data node has been added to Transient Data. ﬂ
[
Select the tabbed panels to configure the transient data set. v

3 In the Input Data tab, select the Data cell for Channel - 1, and click

Import.

This action opens the Data Import dialog box.



Importing Data into the GUI

4 In the Data Import dialog box, select input1, and click Import.

Z1pata Import x|
Import From: IWorkspace VI

Yariahle Name | Size | Bytes | Class |
@im 2011 1608 double 2
@inpuh TO1x1 5608 double —I
@inpum A001 4000 double
@inpuw a00x1 4000 daouble j

% Assign the Following columns ko selected channel(s): |1

(" Assign the Following rows ko selected channel{s): [1:701]

Close | Help |

This action assigns the input data inputi1 to the model input signal
spe_engine_throttlel/Input.

=) Control and Estimation Tools Manager o ] 9

File Wiew Help

e 0| E |
. workspace Inpuit Data | Qutput Data | State Data|
=- W9l Project - spe_enaine_thratth ~#issign data to blacks

B n;?::;;j;.ata Block Mame | Data | Time | Ts | Weight | Length
[i41] Mew Data spe_engine_throttle 1input
g Varibles (charrel-1 [NV | ! [ o
% Estimation

Ea Walidation

Pre-process... Flok Data Clear al |

imp

KT [

- New Data node has been added to Transient Data.

N

Select the tabbed panels ta configure the transient data set.
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5 Select the Time / Ts cell for Channel - 1.
6 In the Data Import dialog box, select time1, and click Import.

This action assigns the time vector to the model input signal
spe_engine_throttlel/Input.

L) control and Estimation Tools Manager

=10l
File Wiew Help
ok D@ ||
s workspace Input Data | Qutput Data | State Data|
EG Project - spe_engine_throtth | accion data to blacks
= - Estimation Task - -
(751 Transient Data Elock Mame I Data | Time | Ts I Weight I Length
;,3] Mew Daka spe_engine_throttle1.nput
variables Channel - 1 [ inputd(;, 1) | Himed(;, 11 | 1 [ 701,701
Estimation
- validation
Impart... Pre-process... Flok Data Clear Al |
KT
- New Data node has been added to Transient Data. ﬂ
[
Select the tabbed panels ta configure the transient data set. v

7 In the Data Import dialog box, click Close.



Importing Data into the GUI

Importing Output Data and Time Vector

To import output data and time vector into the Control and Estimation Tools

Manager GUI:

1 In the Control and Estimation Tools Manger GUI, select the Output Data
tab of the New Data node.

L) control and Estimation Tools Manager

=10l
File Wiew Help
ok D@ ||
s workspace Input Data OUEPUE Data | State Data |
=W Project - spe_engine_thratth ~#ssign data to blacks
B - Estimation Task
T Elock Mame I Data | Time | Ts I Weight Length
spe_engine_throttle1/Position
Yariables Channel - 1 [ I [ 1 -
3 Estimation
- validation
Impart... Pre-process... Flat Data Clear Al |
KT
- New Data node has been added to Transient Data. ﬂ
[
Select the tabbed panels ta configure the transient data set. v

2 Select the Data cell for Channel - 1, and click Import.

This action opens the Data Import dialog box.
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Z1pata Import x|
Import From: IWorkspace VI

Yariahle Name | Size | Bytes | Class |
@kexp 131 g double 2
@positiom TO1x1 5608 double
@positiom A001 4000 double et
@positionB a00x1 4000 daouble j

% Assign the Following columns ko selected channel(s): |1

(" Assign the Following rows ko selected channel{s): [1:701]

Close | Help |

43

This action assigns the output data position1 to the model output signal

spe_engine_throttlel/Position.

3 In the Data Import dialog box, select positioni, and click Import.

=) Control and Estimation Tools Manager o ] 9
File Wiew Help
e 0| E |
. workspace Input Data Output Data | State Data |
=- W9l Project - spe_enaine_thratth ~#issign data to blacks
B - Estirnation Task - -
Transient Data Elock Mame I Data Time | Ts I Weight I Length
[] Mew Daka spe_engine_throttle 1/Position
Oy wariables Channel - 1 1 [ 701)-
L Estimation
Ea Walidation
i Pre-process... Flok Data Clear al |
K] [
- New Data node has been added to Transient Data. ﬂ
[
Select the tabbed panels ta configure the transient data set. A




Importing Data into the GUI

4 Select the Time / Ts cell for Channel - 1.
5 In the Data Import dialog box, select time1, and click Import.

This action assigns the time vector to the model output signal
spe_engine_throttlel/Position.

L) control and Estimation Tools Manager =101 =]
File Wiew Help
cf 0| & [[E

ﬂ Workspace Input Data  Output Data I State Datal
=-¥ghl Project - spe_engine_thratth
= - Estirnation Task

Assign data ko blacks

ansient Data Elock Mame I Data | Time | Ts I Weight I Length
] Mew Daka spe_engine_throttle1/Position
Yariables Chanrel - 1 [ postiontgnty [ tmell,1) ] 1 [ 7014701
% Estimation

- validation

Impart... Pre-process... Flok Data Clear Al |

KT [

- New Data node has been added to Transient Data.

Load projects

s 1 L

6 In Data Import dialog box, click Close.

You have now imported the I/0 data into the Control and Estimation Tools
Manager GUI, and assigned the data to the corresponding model signals.
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Analyzing Data

In this portion of the tutorial, you analyze the output data quality by viewing
the data characteristics on a time plot. Based on the analysis, you decide
whether to preprocess the data before estimating parameters. For example, if
the data contains noise, you might want to filter the noise from the system
dynamics before estimating parameters.

You must have already imported the data into the Control and Estimation
Tools Manager GUI, as described in “Importing Data into the GUI” on page
5-6. If you have not imported the data, click here.

To plot the output data on a time plot, select the positioni(:,1) cell in the
Output Data tab, and click Plot Data.

L) control and Estimation Tools Manager =101 |
File Wiew Help
= = = )
s workspace Input Data OUEPUE Data | State Data |
=W Project - spe_engine_thratth ~#ssign data to blacks
=13 Estimation Task
T B Elock Mame I Data | Time | Ts I Weight I Length
spe_engine_throttle1/Position
: Channel - 1 time1(;,1) [ 1 [ 701701
[ Estimation
- validation
Impart... Pre-process... Flok Data ’\J Clear Al |
| | b
- New Data node has been added to Transient Data. ﬂ
[
Load projects &




Analyzing Data

This action plots the measured output data position1(:,1), as shown in
the next figure.

.} New Data - spe_engine_throttlel /Position = |EI|1|
File Edit Wiew Insert Tools Deskiop Window Help N

AEE I A==
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The time plot shows the output data in response to a step input, as described
in “About the Sample Data” on page 5-2. The plot shows a rapid decrease

in the response after t = 0.5 s because the system is shut down. To focus
parameter estimation on the time period when the system is active, you select
the data samples between t =0 s and t = 0.5 s, as described in “Selecting Data
for Estimation” on page 5-16 section of this tutorial.

The spikes in the data indicate outliers, defined as data values that deviate
from the mean by more than three standard deviations. They may be caused
by measurement errors or sensor problems. The response also contains noise.
Before estimating model parameters from this data, you remove the outliers
and filter the noise, as described in “Removing Outliers” on page 5-25, and
“Filtering Data” on page 5-29 sections of this tutorial.

Tip You can also plot the input data on a time plot by selecting the
inputi1(:,1) cell in the Input Data tab, and clicking Plot Data.
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Selecting Data for Estimation

In this section...

“Selecting Output Data” on page 5-16

“Selecting Input Data” on page 5-22

Selecting Output Data

In this portion of the tutorial, you select a subset of I/O data for estimation.
As described in “Analyzing Data” on page 5-14, the system is shut down at t =
0.5 s. To focus the estimation on the time period before t = 0.5 s, you exclude
the data samples beyond t = 0.5 s. This operation selects the data between

t =0 s and t = 0.5 s for estimation.

You must have already imported the data into the Control and Estimation
Tools Manager GUI, as described in “Importing Data into the GUI” on page
5-6. If you have not imported the data, click here.

To select the portion of data betweent =0 s and t = 0.5 s:

1 In the Control and Estimation Tools Manager window, select the New
Data node under the Transient Data node.



Selecting Data for Estimation

2 Select the positioni(:,1) cell in the Output Data tab, and click

Pre-process.

This action opens the Data Preprocessing Tool GUI.

E! Data Preprocessing Tool for Dataset: New Data x|

Maodify data from I...fthrottlel,l’Position - l Wyrite results to:

~Data Editing

 Existing dataset |w DataLI * new dataset IDatasetl

Raw data I Modified data I

Time {seconds) pasition1{:, 1}
0.0 15,116 =]
1.0e-3 15.964 —
2.0e-3 15.241
3.0e-3 15.993
4.0e-3 15.376
5.0e-3 15.997
6.0e-3 15.380
7.0e-3 15.100
5.0e-3 15.649
9.0e-3 25.592
1.0s-2 15.94¢
1.100e-2 15.238
1.200e-2 15.817
1.300e-2 15.385 =

- Excluded by arule
tdanually excluded

Exclude Graphically |

Exclusion Rules I DetrendjFiltering |

[~ Bounds
Exclude &: I = j I Exclude =: I = j I
Exclude ¥: I <= d I Exclude ¥: I = d I
[ oOutliers

window length: IID

Confidence limits (%) |25

[~ MATLAE expression Iabs(x)>1
[ Flatines ‘Window: |5

~Missing Data Handling

[~ Remave rows where

all

- | data is excluded or missing

[~ Interpolate missing values using interpolation method | zoh i

Add | Close | Help |

The Data Editing area of the Data Preprocessing Tool GUI shows the
output data and time vector in the position1(:;,1) and Time (seconds)
columns, respectively. The Data Preprocessing Tool GUI lets you perform
the following types of preprocessing operations:

¢ Excluding data

¢ Detrending and filtering data

¢ Handling missing data

3 To exclude the output data beyond t = 0.5 s:

a In the Exclusion Rules tab, select the Bounds check box.
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b In the Exclude X I == :|T field, where X corresponds to the time vector,
select > from the drop-down list. Enter 0.5 in the adjacent field to specify
the upper limit of the data to select for estimation.

The Data Preprocessing Tool GUI resembles the next figure.

[E]pata Preprocessing Tool for Dataset: New Data

Modify data fram I..._throttlel,l’Position - I Wite results to:

Data Editing

™ existing dataset | Data + {* new datasst IDatasatl

Raw data I Madified data I

Time (seconds) position1i:, 13

0.0 15.116 a|
1.0e-3 15.964 =
2.0e-3 15.241

3.0e-3 15,993

#.0e-3 15,376

5.0e-3 15,997

&, 0e-3 15,380

7.0e-3 15,100

8,03 15,649

9.0e-3 25,592

1.0e-2 15,944

1,100e-2 15,238

1,200e-2 15,817

1,300e-2 15,385 -

- Excluded by arule
Manually excluded

Exclude Graphically |

Exclusion Rules I DetrendjFiltering |

¥ Bounds

Exclude & | <= 'l I Exclude =t I E vl ID.S
Exclude ¥: | <= 'l I Exclude ¥: I = 'l I

[ Outliers

Window length: IID
Confidence limits (%) |95

[~ MATLAE expression Iabs(x)>1
I~ Flatines ‘Window: |5

~Missing Data Handling

[~ Remave rows where

all

~ | data is excluded or missing

[~ Interpolate missing values using interpolation method | 2ok -

Add | Close | Help |




Selecting Data for Estimation

¢ Click Add.

This action adds a new Datasetl node under the Transient Data node
in the Control and Estimation Tools Manager GUI. The Datasetl node
contains the modified output data positioni(:,1)* in the Output
Data tab.

L) control and Estimation Tools Manager =101 =]
File Wiew Help
ok D@ ||
s workspace Input Data OUEPUE Data | State Data |
=W Project - spe_engine_thratth ~#ssign data to blacks
B - Estimation Task
T Elock Mame I Data | Time | Ts I Weight I Length
spe_engine_throttle1/Position
Channel - 1 [ positiont(, 0+ ] time1(:, 1)* [ 1 [ 701701
Impart. .. Pre-process... Flat Data Clear all |
1 | B
E
[
Select the tabbed panels ta configure the transient data set. v
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This operation also replaces the output data samples beyond t =0.5 s
in positioni(:,1)* with NaNs. You can view the NaNs by selecting the
Modified data tab in the Data Preprocessing Tool GUI, as shown in
the next figure.

[E]pata Preprocessing Tool for Dataset: New Data x|
Modify data fram I..._throttlel,l’Position - I Write results ko existing dataset  |Datassbl + {* new datasst IDatasatZ
Data Editing

Raw data  Modified data I Exclusion Rules I Detrend|Filtering |

Time (seconds) position1(:, 1)*

0457 90,331 {2

0,495 90,323

0,493 90,816 Exclude & | <= 'l I Exclude =t I E vl ID.S

0,500 90,330

0,501 Hatl Exclude ¥: | <= 'l I Exclude ¥: I = 'l I

0,502 Ma

0,503 Ma

0,504 Mald [~ Outliers

0,505 Mal

0,506 Matd ' ‘ I —

fim i Window length: 10

0,508 Mah

0509 Nah Confidence limits (%) |95

0.510 WE -

[~ MATLAE expression Iabs(x)>1
- Excluded by arule
Exclude Graphically | . l—
FRed text Manually excluded I™ Flatines Window: |5

~Missing Data Handling

[~ Remove rows where | 2l = | data is excluded or missing [~ Interpolate missing values using interpolation method | 2ok -

Close | Help |

4 To remove the NaNs:

a In the Control and Estimation Tools Manager GUI, select the Output
Data tab of the Dataset1 node.

b Select the positioni(:,1)* cell, and click Pre-process.

This action updates the Data Preprocessing Tool GUI with the selected
data positioni(:,1)*.
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¢ In the Missing Data Handling area, select the

all

h . . .
Remove rows where data is excluded or missing check box.

E! Data Preprocessing Tool for Dataset: Datasetl x|
Maodify data Fram I..._thrnttlel,l’Pmsitinn - l Wirite results ko existing dataset IDatasetl e {* new dakaset IDatasatZ

Data Editing
Raw data Modified data I Exclusion Rules I Detrend|Filtering |
Time (seconds; position1(:,1)%*
- [~ Bounds
0,457 90,604 =]
0,435 90,533
0,453 90,105 Exclude #: | <= VI I Exclude =: I = VI I
0,490 90,592
0.491 90.72 Exclude ¥: | <= VI I Exclude ¥: I = VI I
0,492 90,648
0,493 90,772
0,454 a0,432 I Outliers
0,495 90,562
DAED EUAD Window length: IID—
0,497 90,331
0.498 90,323 . lgs—
0409 90,516 . onfidence limits (%)
0.500 90,850 =]

[~ MATLAE expression Iabs(x)>1
- Excluded by arule
Exclude Graphically | . X
Red text fdanually excluded I” Flatines Window: |5

Missing Data Handling

al = | datais excluded or missing [~ Interpolate missing values using inkerpolation method | 20h b

Add | Clase | Help |

Tip You can view the results of this operation in the Modified data tab.

d In the Write results to area, select the existing dataset Datasetl j‘
option.

IModify data FromI..._throttlel,l'Position VI Wite results ko: (% existing dataset  |Datasetl v " new dataset IDatasetZ
e Click Add.

The Update table data dialog box appears. Click Yes to overwrite the
positioni(:,1)* data set with the modified data.
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5 To plot the data, select the position1(:,1)* cell in the Output Data tab
of the Datasetl node, and click Plot Data.

The selected output data from t =0 s to t = 0.5 s is shown in the next figure.

) Dataset1 - spe_engine_throttel/Position = |E||1|
Fil= Edit Yiew Insert Tools Desktop Window Help »
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Selecting Input Data

After you select the output data between t =0 s and t = 0.5 s, as described in
“Selecting Output Data” on page 5-16, you must also select the corresponding
input data samples. This operation makes the number of I/O data samples
equal.

1 In the Control and Estimation Tools Manger GUI, select the New Data
node under the Transient Data node.

2 In the Input Data tab, select the input1(:,1) cell, and click Pre-process.

This action updates the Data Preprocessing Tool GUI with the selected
data inputi(:,1).
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3 To exclude the data beyond t = 0.5 s:

a In the Exclusion Rules tab, select the Bounds check box.

b In the Exclude X | ™= = field, where X corresponds to the time vector,
select > from the drop-down list. Enter 0.5 in the adjacent field to specify
the upper limit of the input data to select for estimation.

¢ In the Write results to area, verify that the
existing dataset Datasetl :Iv option remains selected.
d Click Add.
This action adds the modified data input1(:,1)* to the Input Data
tab of the Datasetl node. This operation also replaces the input data
samples beyond t = 0.5 s in input1(:,1)* with NaNs.
4 To remove the NaNs:

a In the Control and Estimation Tools Manager GUI, select the
inputi(:,1)* cell in the Input Data tab of the Datasetl node, and
click Pre-process.

This action updates the Data Preprocessing Tool GUI with the selected
data input1(:,1)*.

b In the Missing Data Handling area, select the

| data is excluded or missing check box.

Remove rows where |
¢ In the Write results to area, verify that the
existing dataset Datasetl :Iv option remains selected.

d Click Add.

The Update table data dialog box appears. Click Yes to overwrite the
inputi(:,1)* data set with the modified data.
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5 To plot the data, select the input1(:,1)* cell in the Input Data tab of the
Datasetl node, and click Plot Data.

The selected input data from t =0 s to t = 0.5 s is shown in the next figure.

) Dataset1 - spe_engine_throtHe 1,/ Tnput = |E||1|
Fil= Edit Yiew Insert Tools Desktop Window Help »
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Removing Outliers

In this section...

“Why Remove Outliers” on page 5-25

“How to Remove Outliers” on page 5-25

Why Remove Outliers

Outliers are data values that deviate from the mean by more than three
standard deviations. When estimating parameters from data containing
outliers, the results may not be accurate.

Removing outliers replaces the data samples containing outliers with NaNs,
which represent missing data. You interpolate the missing data values in a
subsequent operation, as described in “Interpolating Missing Data” on page
5-34.

How to Remove Outliers

In this portion of the tutorial, you remove outliers from the output data. You
must have already selected a subset of the data, as described in “Selecting
Data for Estimation” on page 5-16. If you have not done this preparation,
click here.

1 In the Control and Estimation Tools Manger, select the positiont(:,1)*
cell in the Output Data tab of the Datasetl node, and click Pre-process.

This action updates the Data Preprocessing Tool GUI with the selected
data positioni(:,1)*.
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2 In the Exclusion Rules tab, select the Outliers check box.

By default, the Window length and Confidence limits fields are set to
10 and 95 respectively. The Window length field specifies the number

of successive data samples the software uses to compute the mean and
standard deviation. The Confidence limits field specifies the threshold
number for identifying outliers. In this example, the mean and standard
deviation of 10 successive data samples are computed, and data values that
exceed 95% of standard deviation are identified as outliers.

E! Data Preprocessing Tool for Dataset: Datasetl x|
Modify data FrnmI..._thrnttlel,l’Pnsitinn vl Wirite results ko: (% existing dataset IDatasetl - i new dakaset IDatasatZ
Data Editing

Raw data Modified data I Exclusion Rules I Detrend|Filtering |

Time {seconds) position1(:, 1%
: [ Bounds

5,003 15.643 =]

9.0e-3 Mald —!

1.0e-2 15.944 Exclude x: I <= LI | Exclude x: I = ;I |

1,100e-2 15,238

1.200e-2 15.817 Exclude ¥: I <= LI | Exclude ¥: I = ;I |

1,300e-2 15,385

1,400e-2 16,11

1.500e-2 15879 [ Outliers

1,600e-2 15,748

ez a2y Window lenath; IID

1.800e-2 14,688

1.900e-2 Mah

n A
> o2 15391 Confidence limits {%): |95
=z 100e-2 14.742 =
[~ MATLAE expression Iabs(x)>1
- Excluded by arule
Exclude Graphically | . X
Red text fdanually excluded I” Flatines Window: |5

Missing Data Handling

[~ Remove rows where | all | data is excluded or missing [~ Interpolate missing values using inkerpolation method | 20h b

add | cose |[i

Note The data samples containing outliers are replaced with NaNs.

3 In the Write results to area, verify that the existing dataset Datasetl jv
option remains selected.
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4 Click Add.

The Update table data dialog box appears. Click Yes to overwrite the
positioni(:,1)* data set with the modified data.

5 To plot the data, select the positioni(:,1)* cell in the Output Data tab
of the Datasetl node, and click Plot Data.

The spikes, which indicate outliers, no longer appear on the time plot,
as shown in the next figure.

) Datasetl - spe_engine_throttlel/Position o |EI|1|
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The missing data samples, represented by NaNs, appear as gaps on the
time plot. To see an example, zoom in to the bottom-left corner of the plot.
As shown in the next figure, the data values corresponding to t = 0.009 s
and t = 0.019 s are missing.
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Filtering Data

In this section...

“Filtering Output Data” on page 5-29

“Filtering Input Data” on page 5-32

Filtering Output Data
In this portion of the tutorial, you filter the noise, and remove any periodic

trends from the output data. To avoid relative phase shift between the I/0
data, you must also apply the same filter to the input data.

You must have already removed outliers from the output data, as described
in “Removing Outliers” on page 5-25. If you have not done this preparation,
click here.

1 In the Control and Estimation Tools Manager window, select the
positioni(:,1)* cell in the Output Data tab of the Datasetl node, and
click Pre-process.

This action updates the Data Preprocessing Tool GUI with the selected
data positioni(:,1)*.
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5-30

2 In the Detrend/Filtering tab:

a Select the Filtering check box.

By default, First order is selected as the filter type. To learn more
about the filters, see “Filtering Data”.

b Specify 0.001 in the First order filter with time constant field.

This field specifies the time constant for the first-order filter.

Tip For calculating the time constant, you can visually inspect the time
plot to determine the frequency components.

E! Data Preprocessing Tool for Dataset: Datasetl LI
Modify data fram I..._throttlel,l’Position - l Write results ko existing dataset  |Datasebl {* new dataset IDatasatZ
~Data Editing

Raw data | Madified data | Exclusion Rules  DetrendFiltering |

Tirne: (seconds) position1(:, 13*
G i :I I~ Detrending % Comsbant
H —

L8 15.964 ¢ Straight Line

2.0e-3 15.241

3.0e-3 15,993

03 13,378 ¥ Filtering ~ Select Filter type I First arder - l

5.0e-3 15,997

6,0e-3 15,380

7.0e-3 15,100

First arder filter with time conskant IEI.EIEII

8.0e-3 15,649

9.0e-3 Mal

1,0e-2 15,944

1,100e-2 15,238

1,200e-2 15,817

1,300e-2 15,385 LI

- Excluded by arule
Exclude Graphically |
Red text Manually excluded

~Missing Data Handling

[~ Remove rows where I al = l data is excluded or missing [~ Interpolate missing values using interpolation method | 2ok -

Add | Close | Help |

3 In the Write results to area, verify that the existing dataset Datasetl :Iv
option remains selected.




Filtering Data

4 Click Add.

The Update table data dialog box appears. Click Yes to overwrite the
positioni(:,1)* data set with the modified data.

5 To plot the data, select the positioni(:,1)* cell in the Output Data tab
of the Datasetl node, and click Plot Data.

The noise is filtered and the output data appears smooth, as shown in
the next figure.
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Filtering Input Data

After you filter the output data, as described in “Filtering Output Data” on
page 5-29, you must also filter the input data with the same filter.

In the Control and Estimation Tools Manager window, select the
inputi(:,1)* cell in the Input Data tab of the Dataset1 node, and click
Pre-process.

This action updates the Data Preprocessing Tool GUI with the selected
data inputi(:,1)*.

In the Detrend/Filtering tab:
a Select the Filtering check box.

By default, First order is selected as the filter type.
b Specify 0.001 in the First order filter with time constant field.

In the Write results to area, verify that the existing dataset Datasetl :|v
option remains selected.

Click Add.

The Update table data dialog box appears. Click Yes to overwrite the
inputi1(:,1)* data set with the modified data.



Filtering Data

5 To plot the data, select the input1(:,1)* cell in the Input Data tab of the
Datasetl node, and click Plot Data.
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Interpolating Missing Data

In this portion of the tutorial, you interpolate the output data to compute the
missing values created when removing outliers, as described in “Removing
Outliers” on page 5-25. The interpolation operation uses the known data
values to compute the missing data values.

You must have already filtered the noise, as described in “Filtering Data” on
page 5-29. If you have not already done this preparation, click here.

1 In the Control and Estimation Tools Manager GUI, select the
positioni(:,1)* cell in the Output Data tab of the Datasetl node, and
click Pre-process.

This action updates the Data Preprocessing Tool GUI with the selected
data positiont(:,1)*.
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2 In the Missing Data Handling area, select the Interpolate missing
values using interpolation method check box.

By default, zoh is selected as the interpolation method. This method fills
the missing data sample with the data value immediately preceding it.

E! Data Preprocessing Tool for Dataset: Dataset1
Maodify data from I...fthrottlel,l’Position - l Write results ko: (% existing dataset  [Datasetl -+ " new dataset IDatasetZ
Data Editing

Raw data Modified data I Exclusion Rules I DetrendFiltering |

Time {seconds) position1(:, 17+*

0.0 15,116 || e

1.0e-3 15.964 —!

2.0e-3 15.241 2 — 2 =

Exclude &: | <= = Exclude 2 | »= =
3.0e-3 15.993 I J I I J I
4. 0e-3 15.376 2 — 2 —
Exclude ¥: | <= = Exclude : | »= =

5 0e-3 15,997 I J I I J I

6,03 15,380

7,023 15.100 I™ Outliers

5,023 15,649

9,0e-3 15,649 " . I—

- 5 window length: 10

1,100e-2 15,238

120082 15.617 Confidence limits (%) |25

1,300e-2 15,385 LI

[~ MATLAE expression Iabs(x)>1
- Excluded by arule
Exclude Graphically | Jati -,
Red text tanually excluded I™ Flatlines Window: |5
[
La

Missing Data Handling

[~ Remove rows where | all | data is excluded or missing -

Add | Close | Help |

Tip You can view the interpolated data samples in the Modified data tab.

3 In the Write results to area, verify that the existing dataset Datasetl :|v
option remains selected.

4 Click Add.

The Update table data dialog box appears. Click Yes to overwrite the
positioni(:,1)* data set with the modified data.
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5 To plot the data, select the position1(:,1)* cell in the Output Data tab
of the Datasetl node, and click Plot Data.

The new estimation data, prepared by removing outliers, filtering noise,
and interpolating missing data, is shown the next figure.

) Datasetl - spe_engine_throttlel /Position = |EI|5|
File Edit ‘iew Insert Tools Deskbop  Window  Help o
Do de B|ARAODLRL-2|0BE| 8O
Data plot for port
spe_engine_throttle1/Position

100 -

80

g0

70

B0

50

Arnplitude

40

30

20

10

D 1 1 1 1 1 1
0 nos 01 O1a 02 02 03 035 04 045 05
Tirme
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Saving the Project

After you prepare the data, you can delete the data in the New Data node,

rename the prepared data, and save the session. To skip the data preparation
steps, click here.

1 In the Control and Estimation Tools Manger GUI, select the New Data
node under the Transient Data node.

2 Right-click the New Data node, and select Delete.
3 Select the Datasetl node under the Transient Data node.

4 Right-click the Datasetl node, and select Rename. Specify
Estim_Data_Prep as the name of the new estimation data set.

The Control and Estimation Tools Manager GUI resembles the next figure.

E! Control and Estimation Tools Manager

5 =] 3
File Wiew Help
D=2 HE|
. workspace Input Data | Output Data | State Data |
=gl Project - spe_engine_throttlel Assign data ta blocks
[=-F3)] Estimation Task
EBlock Mame | Data I Time | Ts | Weight I Length
- Diata | spe_engine_throttle 1input
Yariables Charinel - 1 [ imputagnne [ wmeng, it ] 1 [ 501/501
[#-Legd Estimation
Ea Walidation
Impott... Fre-process, .. Flat Data Clear All |
e
[
Select the tabbed panels ta configure the transient data set. 4
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5 Save the Control and Estimation Tools Manager project:

a In the Control and Estimation Tools Manager GUI, select File > Save.

This action opens the Save Projects dialog box.

b In the Save Projects dialog box, click OK.

) save projets———SRIF]

Projects:

Project - spe_engine_throttled

[

(04 | Cancell Helpx |

¢ In the Save Projects window, specify spe_engine_throttleip.mat in
the File name field, and click Save.

The action saves the project as a MAT-file.

To learn how to estimate parameters from this data, see Chapter 6, “Tutorial
— Estimating Parameters from Measured Data Using the GUI”.



Tutorial — Estimating
Parameters from Measured

Data Using the GUI

“About This Tutorial” on page 6-2

“Estimating Model Parameters Using Default Estimation Settings” on
page 6-7

* “Improving Estimation Results Using Parameter Bounds” on page 6-20

“Validating Estimated Model Parameters” on page 6-26
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About This Tutorial

In this section...

“Objectives” on page 6-2
“About the Model” on page 6-3

Obijectives

In this tutorial, you learn how to estimate parameters of a single-input

single-output (SISO) Simulink model from measured input and output (I/O)
data.

Note Simulink Design Optimization software estimates parameters from
real, time-domain data only.

You learn to perform the following tasks using the GUI:

® Load a saved project containing data.
¢ Estimate model parameters using default settings.

e Validate the model, and refine the estimation results.
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About the Model

In this tutorial, you use the spe_engine_throttlel Simulink model. This
model represents an engine throttle system, as shown in the next figure.

=i
File Edit Yiew Simulation Format Tools Help
D|D"H§|éﬂﬁ|<}==b?|f>e|b IIEI.5 INormaI ﬂmi_!@
Engine Throttle Model
Copyright (2] 2002-2004 The MathWorks, Inc.

CO—y »

Inut Throttl

rottle

Matar ] 1 Pasition

Throttle .(D

Fosition
Ready [122%% [ [ |ode4s >

The throttle system controls the flow of air and fuel mixture to the engine
cylinders. The throttle body contains a butterfly valve which opens when a
driver presses the accelerator pedal. Opening this valve increases the amount
of fuel mixture entering the cylinders, which increases the engine speed. A
DC motor controls the opening angle of the butterfly valve in the throttle
system. The models for these components are described in “Motor Subsystem”
on page 6-4, and “Throttle Subsystem” on page 6-5.

The input to the throttle system is the motor current (in amperes), and the
output is the angular position of the butterfly valve (in degrees).
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Motor Subsystem
The Motor subsystem contains the DC motor model. To open the model,
double-click the corresponding block.

E!spe_engine_thrutl:le1,.-"Mul:ur - |I:I|£|
File Edit Mew Simulation Formak  Tools  Help

D ES| BB et |2

T

Toroque
Fain

Fl1o0%

| |ode4s v

The following table describes the variables, parameters, equation, input,
and output of the Motor subsystem.

Variables U is the input current to the motor.
T is the torque applied by the motor.

Parameters K, is the torque gain of the motor, represented by Kt in the
model.
t, is the input time delay of the motor, represented by
input_delay in the model.

Equation The torque applied by the motor is described in the
following equation:

T =K, U({t-ty)

where ¢ is time.

Input U

Output T
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Throttle Subsystem

The Throttle subsystem contains the butterfly valve model. To open the
model, right-click the corresponding block, and select Look Under Mask.

E!spe_engine_thruttle1,.-"Thrott|e ;IEIEI
File Edit Yiew Simulation Format Tools Help
DSE&| 2R (e 4| r s [Nom HJRepeE RE
Velocity Pozition
»i
. x
Inertia rad-to-deg
b Felaxed
Aupang Pozition
il
~E]
Spring
F 2 ot
Hard Stops
Ready [100% [ [ [ode4s 7

The Hard Stops block models the valve angular position limit of 15° to 90°.

The following table describes the variables, parameters, states, differential
equations, inputs, and outputs of the Throttle subsystem.

Variables T is the torque applied by the DC motor.

6 is the angular position of the valve, represented
by x in the model.

T}rasiop 18 the torque applied by the hard stop.

Parameters J is the inertia.
¢ is the viscous friction.

k is the spring constant.

States 0 is the angular position.

0 is the angular velocity.
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Equations

The mathematical system for the butterfly valve
is described in the following equation:

Je s cé +kO=T+ Thardstop

where 15° <0<90°, with initial conditions

09 =15°, and 90 =0 .The torque applied by the
Hard Stops block is described in the following
equation:

0, 15° <6 <90°
Thardstop =1K(90° -6),6 >90°
K(15°-0),6<15°

where K is the gain of the Hard Stops block.

Input

Output
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Estimating Model Parameters Using Default Estimation

Settings

In this section...

“Overview of the Estimation Process” on page 6-7

“Specifying Parameters and Estimation Data” on page 6-8

“Validating Model Parameters” on page 6-13

Overview of the Estimation Process

Simulink Design Optimization software uses optimization techniques to
estimate model parameters. In each optimization iteration, the model

is simulated with the current parameter values. The error between the
simulated and measured output is computed and minimized. The estimation
is complete when the optimization algorithm finds a local minimum.

You perform the following tasks to estimate the model parameters:

® “Specifying Parameters and Estimation Data” on page 6-8

® “Validating Model Parameters” on page 6-13
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Specifying Parameters and Estimation Data
To specify parameters and estimation data:

1 Load the preconfigured project spe_engine throttleip.mat.

This MAT-file contains the estimation data. To learn more about the data

and how to prepare it, see Chapter 5, “Tutorial — Preparing Data for

Parameter Estimation Using the GUI”.

To load the preconfigured project:

a Open the engine throttle system Simulink model by typing the following
at the MATLAB prompt:

spe_engine_throttlel

b In the Simulink model window, select Tools > Parameter Estimation.

This action opens a new project named Project - spe_engine_throttlel
in the Control and Estimation Tools Manager GUI.

¢ In the Control and Estimation Tools Manager GUI, select File > Load.
Browse to the matlabroot\toolbox\sldo\sldodemos\estim directory
and select spe_engine_throttlelp.mat.

The Confirm Node Replace dialog box appears. Click Yes to load the
project into the Control and Estimation Tools Manager GUI.
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The Controls and Estimation Tools Manager GUI opens as shown in the

next figure.

E! Control and Estimation Tools Manager

5 =] 3
File Wiew Help
==
4 Workspace Input Data | Output Data I State Data I
=-Tghl Project - spe_engine_throttlel Assign data ta blocks
=) Estimation Task - -
- [ Transient Data EBlock Mame | Data I Time | Ts | Weight I Length
: spe_engine_throttie 1Anput
Yariables Charinel - 1 [ imputagnne [ wmeng, it ] 1 [ 501/501
Estimation
Ea Walidation
Impott... Fre-process, .. Flat Data Clear All |
e
=
Select the tabbed panels ta configure the transient data set. 4
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2 Specify parameters for estimation.

a Select the Variables node under the Estimation Task node.

E! Control and Estimation Tools Manager o =] 5|
File Wiew Help
===
4:\ Workspace Estimated Parameters | Estimated Statesl
= G Pject - spe_engine_thrattlel ~Selected parameter ~Default setting:
-3 Estimation Task
= Mame:
-] Transient Daka d
. o [i#] Estim_Data_Prep Walue:
3 Initial quess: |
Estimation S I
Ea Walidation il
Maximum;: I
Typical value: |
Referenced by:
=
=
Add... Delete LI
4
[
Select the tab panels to configure your estimation parameters and states. 4

b Click Add.

This action opens the Select Parameters dialog box, which shows the

model parameters for the Simulink model.

¢ Select the parameters J, ¢, input_delay, and k by pressing the Ctrl key
while clicking each name, and then click OK.

This action adds the selected parameters to the Estimated Parameters

tab.




Estimating Model Parameters Using Default Estimation Settings

x
—3elect additional parameters to estimate—————————————
Mame Size
e
Kk 1x1
angle_inik 1x1
angle_open 1x1

|

Specify expression (e.q., s.x, a(3), B{Z:

a4 lg Cancel | Help | apphy |

Tip When estimating a large number of parameters, you can select
a subset of parameters to estimate. To learn more, see the Inverted

Pendulum Parameter Estimation demo in the Demos pane in the
MATLAB Help browser.

d Select the Estimation node, and click New.

This action adds a New Estimation node under the Estimation node.

e Select the New Estimation node.
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In the Parameters tab, select the Estimate check box for all the

parameters.

This action specifies the selected parameters for estimation.

E! Control and Estimation Tools Manager

=10l
File Wiew Help
e = = )
4_:\ Workspace Data Sets Parameters | states| Estimation |
=Wl Praject - spe_engine_throttlel ~Estimation parameter
B[] Estimation Task
- [ Transient Data Mame Yalue Estimate: Initial Guess Miniroum Maximum | Typical Value
I i 0.05 [ i -Inf +Inf 1
i C 40 v C -Inf +Inf c
E Estimation input_delay 0.0z v input_delay -Inf +Inf input_delay

¢ By Mew Estimation
: Ea Views
Ea Walidation

3

Lise Yalue a5 Initial Guess

Reset to Default Settings

Sawe as Default Settings |

k

- NEW Eztimation node has been added

Select the tab panels to configure your estimation.

to Estimatilon.

- New Estimation node has been added to Estimation.

ol

B

The Parameters tab, as shown in the previous figure, displays the
following information for each parameter:

® Value: Current parameter value. By default, it is equal to the value
specified in the Simulink model.

During estimation, the optimization algorithm might change a
parameter value to minimize the error between the measured and

simulated output.

value in the Value field and is used at the start of estimation.

Initial Guess: Initial parameter value. By default, it is equal to the



Estimating Model Parameters Using Default Estimation Settings

¢ Minimum and Maximum: Bounds on the parameter value. By
default, they are set to -Inf, and +Inf, respectively. This means

that the optimization algorithm searches for a solution in the range
[-Inf, +Inf].

e Typical Value: Order of magnitude of the parameter value. By
default, it is equal to the value in the Initial Guess field.

3 Specify data for estimation by checking the Selected check box for
Estim_Data_Prep in the Data Sets tab.

E! Control and Estimation Tools Manager o =] 5|
File Wiew Help

e = = )
4:\ workspace Data Sets | Parameters | States | Estimation |
= T Project - spe_engine_throttel
B[] Estimation Task - —
= [ Transient Data | Transient estimation =1 Block Mame | Length | weight
F [] Estim_Data_Prep spe_engine_throttle1/Position

Data sets used For estimation———————— - Output data weight:

3 variables Data Set Charmel-1 [ soyjsor | 1
E % Estimation Estim_Data_Prep

E% Mew Estimation

: [E Views

[a Walidation

=

Select Al Clear All |

= Wew Lstimatlion node has Deen added Lo Estimation.
- New Estimation node has been added to Estimation.

Load projects

x 9L [

Validating Model Parameters

After you specify parameters and data for estimation, as described in
“Specifying Parameters and Estimation Data” on page 6-8, estimate the

parameters and analyze the results to determine if the model needs to be
refined.
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1 Create plots to view the estimation results.
a Select the Views node under the Estimation node, and click New.
This action creates a New View node under the Views node.
b Select the New View node.

¢ In the View Setup tab, select the following plots from the drop-down
list in the Plot Type column:

¢ For Plot 1, select Measured and simulated.

* For Plot 2, select Cost function.

[l control and Estimation Tools Manager

=loix]
File WYiew Help
ot D | &3 ([E
ﬂ Wworkspace Wigw Setup |
=l Project - spe_endine_thratth | salact plat typ
[=-E31) Estimation Task -
- [} Transient Data Plat Mumber Plat Type Flak Title
¢] Estim_Data Pre Flat 1 Measured and simulated
variables Flot 2 B
Estimation
I E@ Mew Estimation Measured and simulated
= Ea Views Plat 5 Parameter sensikivity
Ll Mew View Plat & Parameter trajectary
Residuals
{none)
[ Opion:
Estimation T
e Estirnation | [l |
Show Ploks |
dl | B
— Wew Estimation node has been added to EStimatbiomn. d
- New View node has been added to Views. [l
=
Configure dynamic views, A
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d In the Options area, select the Plot 1 and Plot 2 check boxes, and
click Show Plots.

E! Control and Estimation Tools Manager o =] 5|
File Wiew Help

o 0| @

4:\ Workspace View Setup I

= G Project - spe_engine_throtth | _cajac plot type:
B[] Estimation Task

= Transient Data Plot Number Plot Type: Plok Title:
P [553] Estim_Daka_Pre Plok 1 Measured and simulated
Variables Plot 2 Cost: function
:E % Estimation Plot 3 (none)
E@ Mew Estimation Plat 4 (none)
A Ea Views Plok 5 (none;
b Mew Yiew Plat & (none)

Ea Walidation

~Opkion:

Estimation | Pt 1 Flot 2
e Estirnation | v f

Show Plots |
4 |

= Wew Lstimatlion node has Deen added Lo Estimation.
- New Wiew node has been added to Views.

Configure dynamic views,

L i

Clicking Show Plots opens the following figures:

® New View - Plot 1 (Measured and simulated): Displays the
measured output data Estim_Prep_Data. During estimation, this plot
updates to display the simulated response at each iteration.

® New View - Plot 2 (Cost function): Displays the error between
the measured and simulated output, computed at each iteration. By
default, the error is computed using sum- of- squared- errors, which is
a least-squares method.

2 Estimate the parameters by selecting the Estimation tab of the New
Estimation node, and clicking Start.
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The Estimation tab updates at each iteration, and provides information
about the estimation progress. When the estimation completes, the
Estimation tab resembles the next figure.

E! Control and Estimation Tools Manager

File Wiew Help

I [=[ 3]

o D= HE

ﬂ Workspace
=B Project - spe_engine_throtte1
[=} - Estimation Task
Transient Data
: --[j{sj] Estirn_Data_Prep
Wariables
% Estimation
E@ Mew Estimation
=- Ea Wiews
Lo New Yiew
Ea Walidation

Data Setsl Parameters | States Estimation |
~Estimation progre:

Active experiments: Estim Data Prep
Estimated parameters: J, c, input_delay, k

Optimization terminated: norm of the current step is less than
OPTIONS. Tol¥

Iteration Function Co..., | Cost Funckion Step Size Procedure Estimation Cptions... |
o 19512+ U0S U U024 T4 N
2 30 1.9507e+005_[0.00061035 E e —
30 31 1.9507e4+005 |0.0012207
31 32 1.9507e+005 |0.00030513
32 33 1.9507e4+005 |7.62942-005
33 34 1.9507e4+005 |0.00015259
34 35 1.9507e4+005 |0.00015259
35 36 1.9507e4+005 |3.8147e-005
[~ Show progress wiews
36 37 1.9507e4+005 |9.5367e-006
37 38 1.9507e4+005 |2.3842e-006
38 39 1.9507e4+005 |5.9605e-007 -
Performing transient estimation... =]

Iteration 348 c:o?plet,e
Estimation completed.

Select the tab panels ka configure your estimation.

s L

Note The results of the optimization may differ slightly because of
different numerical precision across platforms.

The table displays the following information for each iteration:

e Cost Function: Error between the simulated and measured output.

During estimation, the default optimization algorithm Nonlinear
least squares, Isqnonlin, minimizes the cost function by changing the
parameter values. As shown in the previous figure, the cost function
decreases by only 27% from 2.69e5 to 1.95e5.
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® Step Size: Displacement of the optimization algorithm in the current
search direction when minimizing the cost function. A final value close to
zero indicates that the algorithm has found a local minimum. As shown
in the previous figure, the final step size in the last iteration is 5.96e-7.

3 View the estimated parameter values in the Value column of the
Parameters tab.

E! Control and Estimation Tools Manager (o))
File Wiew Help =12
ok O [ & [[E
Q« Workspace
= W@l Project - spe_engine_thratth
=13 Estimation Task
[[3) Transient Data Narme Value
+i] Estim_Data_pre || 12 0.0017013
Wariables c 39,994 c -Inf +Inf c
Estimation input_delay | 0.00016581 input_delay -Inf +Inf input_delay
E@ Mew Estimation k 099359

k -Inf +Inf k
=5 Ea Wigws
o 0 M iew

[g validation

Data Sets Parameters | states | Estimation |
~Estimation pararneter

Estimate Initial Guess Mlinirurn Maximum Typical Yalue

] -Inf +Inf ]

RIS

Wse Yalue a5 Initial Guess Reset b Default Settings
KT

Iteration 37 complete

Save as Default Settings |

Estimation completed.

[
5
Select the tab panels ta configure your estimation.

v

B
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4 Examine the simulated response plot to see how well the simulated output
matches the measured output.

The simulated response with the estimated parameters is shown in
blue on the New View - Plot 1 (Measured and simulated) plot, and
significantly differs from the measured data. This difference indicates that
the estimated parameters are not accurate.

) New View - Plot 1 (Measured and sinulated) : hg - |EI|5|
-]

File Edit ‘iew Insert Tools Deskbop  Window  Help
NEde  LRAOCDEL- (A0 D

Measured vz, Simulated Responses
Estim_Data_Prep
100 T T T T T T T T T

Amplitude
Position

0
o 005 0.1 015 0.2 0.25 0.3 0.35 0.4 045 04a
Time (sec)
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5 Examine the cost function plot to see how the cost function changes during
the estimation.

The cost function values shown in step 2 are plotted on the New View -
Plot 2(Cost function) plot. The cost function decreases by only 27%
from its initial value, and in conjunction with the measured and simulated
output plot, indicates that the estimated parameters are not accurate.

) New View - Plot 2 (Cost function) : - |EI|5|
File Edit ‘iew Insert Tools Deskbop  Window  Help o
DEEL K RAODEL- Q0B 8O
Cost Function
T T T T T T
107t -
w
[m]
O
1oL i
1 1 1 1 L 1
a 5 10 15 20 25 30 a9
terations

To improve the estimation results, you apply bounds on the parameter values,
as described in “Improving Estimation Results Using Parameter Bounds”
on page 6-20.
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Improving Estimation Results Using Parameter Bounds

In this section...

“Strategy for Improving the Estimation Results” on page 6-20

“How to Specify Parameter Bounds” on page 6-20

Strategy for Improving the Estimation Results

Analyzing the Measured and Simulated and Cost function plots, as
described in “Validating Model Parameters” on page 6-13, you see that the
model parameters estimated using the default estimation settings are not
accurate. You must run additional estimations to improve the accuracy of the
model. There are several techniques to improve the accuracy of the estimated
parameters. For more information, see “How to Specify Estimation Options
in the GUI”.

In this portion of the tutorial, you improve the results by specifying bounds
on parameter values. This technique restricts the region in which the
optimization algorithm searches for a local minima.

Based on physical insight, you know the following characteristics of the
engine throttle system:

e All the parameter values are positive.

¢ Maximum time delay of the system, represented by input_delay, is 0.1 s.

Therefore, you specify 0 as the minimum value for all parameters, and 0.1 as
the maximum value of input_delay.

After you estimate the parameters, analyze the results using the Measured
and Simulated and Cost function plots.

How to Specify Parameter Bounds

You must have already estimated the parameters using default settings,
as described in “Estimating Model Parameters Using Default Estimation
Settings” on page 6-7.
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To improve the estimation results by specifying parameter bounds:
1 Select the Parameters tab of the New Estimation node.

2 Specify the minimum value for each parameter by double-clicking the
corresponding Minimum cell, and replacing - Inf with 0.

3 Specify the maximum value for input_delay by double-clicking the
corresponding Maximum cell and replacing +Inf with 0.1.

The Parameters tab resembles the next figure.

E! Control and Estimation Tools Manager

File Wiew Help

5 =] 3
o D= HE
{\ Warkspace Data Sets  Parameters | States | Estimation |
EG Project - spe_engine_throtth | _epination parameter
-- Estimation Task
(5 Transient Data Mame Yalue Estimate Initial Guess Mlinimum Maximum Typical Value
il 0.0017013 v 1 a +Inf )
c 39,994 2 C [i +Inf c
Estimation input_delay 0.00016%81 ¥ input_delay 0
- B Mew Estimation k v k a

nput_delay
=5 E Wigws
Lo M Wiew
G Walidation

Use Value as Initial Guess Reset to Default Settings Save as Default Settings |
4 | &l
Iteration 37 c:o?plet,e ;I
Estimation completed.
5
Select the tab panels ka configure your estimation. 4
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4 Select the Estimation tab, and click Start.

The Estimation tab updates at each iteration, and provides information
about the estimation progress. When the estimation completes, the
Estimation tab resembles the next figure.

E! Control and Estimation Tools Manager

File Wiew Help

e 0= 3|

4:\ Workspace
- T Project - spe_engine_throtth

(-] Estimation Task

E] lﬁ Transient Data

553] Estirn_Data_Pre
: Wariables
=] Estimation
E% Mew Estimation
=] [E Views

Lo Mew Wiew
[a Walidation

4 | o

Data Setsl Parameters | States Estimation |

~Estimation progre:

Iteration Function Count | Cost Function Step Size Procedure Estimation Options.. . |
0 [T |
36 37 239.96 0.01434 Display Optians. ..
37 33 239.96 0.003555
35 39 239.96 0.00039624
39 40 239.96 0.00022406
40 41 239.95 5.60152-005
41 42 239.95 5.60152-005
4z 43 239.95 1.4004e-005 (] Sy s RS
43 44 239.94 3.5009e-005
44 45 239.94 3.5009e-005
45 45 239.94 5.75242-007 -
Performing transient estimation... [=]
Active experiments: Estim_Data_Prep
Estimated parameters: I, c, input_delay, k
Optimization terminated: norm of the current step is less than
OPTIONS. TolX.
[

Tteration 45 complete
Estimation comwpleted.

Save projecks

x 9L [

Note The results of the optimization may differ slightly because of
different numerical precision across platforms.

The cost function decreases by 99% from 1.95e5 to 239.94. The final step
size 8.75e-7 is close to 0, which indicates that the optimization algorithm
has found a local minimum.
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5 View the estimated parameter values in the Value column of the
Parameters tab.

E! Control and Estimation Tools Manager o =] 5|
File Wiew Help
e 0= 3
4_1 Warkspace Data Sets  Parameters | States | Estimation |
=2 G Project - spe_engine_throtth | _gepination parameter
=] Estimation Task
Transient Data Mame alue Estimate Initial Guess Minimum Maximurm Typical Value
- [41] Estim_Data_pre || |2 0.22295 v J 0 +Inf 1

i Variables c 9.0178 v c 0 +Inf c

=[5 Estimatian input_delay 0,0090554 v input_delay 0 0.1 input_delay

By New Estimation k 20,216 cd k 0 +1Inf k

=] Ea Views
Lo Mew Wiew
Ea validation
Use Walue a5 Initisl Guess Reset bo Default Settings Sawe as Default Sethings |
l | B
Tteration 45 complete |
Estimation comwpleted.
5
Select the tab panels to configure your estimation. v
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6 Examine the simulated response plot to see how well the simulated output
matches the measured output.

The simulated response plot, shown in blue on the New View - Plot 1
(Measured and simulated) plot, is overlaid on the measured output data.
The simulated output closely matches the measured data.

) New View - Plot 1 (Measured and sinulated) : - |EI|5|

File Edit ‘iew Insert Tools Deskbop  Window  Help o
NEde  LRAONDEL- (A0 aD
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0 L L L L 1 1 L L L
1] 005 0.1 015 0.z 0.25 03 0.35 0.4 0.45 05
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7 Examine the cost function plot to see how the cost function changes during
the estimation.

The cost function values shown in step 4 are plotted on the New View

- Plot 2(Cost function) plot. The cost function also decreases by

99% from its initial value, and in conjunction with the measured and
simulated response plot indicates a good fit of the simulated response with
the measured data.

) New Yiew - Plot 2 (Cost function) : i |
File Edit Yiew Insert Tools Desktop ‘Window Help a
o = =
NG HdS 5 [RRTDE 42 (0EaT
5 Cost Function
10 T T T T T T T T
10° 1 .
E o't 5
(5}
107k .
102 | 1 | 1 | 1 1 |
0] & 10 15 20 25 30 35 40 45
fterations
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Validating Estimated Model Parameters

After you estimate the model parameters, as described in “Improving
Estimation Results Using Parameter Bounds” on page 6-20, validate the
model using another data set (validation data). A good match between the
simulated response and the validation data indicates that you have not
overfitted the model.

To validate the estimated parameters using a validation data set:
1 Load the preconfigured project spe_engine_throttlel1_importValDatai.mat.
This MAT-file contains a validation data set already imported into the

GUI, and the estimated parameters as described in “Improving Estimation
Results Using Parameter Bounds” on page 6-20.

Tip To learn how to import data and time vector into the Control and
Estimation Tools Manager GUI, see “Importing Data into the GUI” on
page 5-6.

To load the preconfigured project:
a In the Control and Estimation Tools Manager GUI, select File > Load.

b Browse to the matlabroot\toolbox\sldo\sldodemos\estim directory,
and select spe_engine_throttlel importvalDatal.mat.

The Confirm Node Replace dialog box appears. Click Yes to load the
project into the Control and Estimation Tools Manager GUI.

The Control and Estimation Tools Manager GUI now has a node that
contains the validation data, as shown in the next figure.



Validating Estimated Model Parameters

E! ‘Control and Estimation Tools Manager i =] [

File View Help

=il N = = W [E5)

. Workspace Input Data | Queput Dat | State Data|
=- Mgl Project - spe_engine_thrattlel ~Assign data to blacks
=) Estimation Task - -
[F Transient Data Block Mame | Data I Time [ Ts | ‘Weight I Length
Estim_Data_Prep spe_engine_throttle1/input
datio Channel-1 | inpue2(,1) [ mme2(1) | 1 [ soo/s00
+ %Est\mation
Ea Walidation
Import... Fre-process, .. Flot Data Clear all |
E
[
v

Select the tabbed panels ko configure the transient data set.

The validation data contains the input data, output data and time vector in
the MATLAB variables input2, position2 and time2 respectively.

2 Plot the measured and simulated response, and residuals.

a Select the Validation node, and click New.

This action creates a New Validation node.
b Select the New Validation node.

¢ In the Validation Setup tab, select the following plots in the Plot
Type column.

* For Plot 1, select Measured and simulated.
* For Plot 2, select Residuals.
d In the Options area, select the Plot 1, and Plot 2 check boxes.
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e Select Validation Data 1 from the Validation data set drop-down

list.

The Validation Setup tab resembles the next figure.

E! Control and Estimation Tools Manager o =] 5
File View Help
e = = )
4:\ Workspace Validation Setup I
= T Project - spe_engine_throttel ~Select plat bype:
-] Estimation Task -
= nsient Data Flot Mumber Flot Type Flot Title
Estim_Daka_Prep Plat 1 Measured and simulated
Yalidation Data 1 Plot 2 Residuals
Yariables Plot 3 (none)
=] Estimation Plot 4 (none)
¢ B Mew Estimation Flot 5 (none)
= anaws Plat & (none)
Lol Mew iew
=] Ea Walidation
. Mew Validati
@ ew Yalidation ~option
Walidation data sef: I Walidation Data 1 LI
Estimation | pot1t | poez |
Mewvs Estimation | v | ¥ |
= Wew Data hode has been added to ILansient Data. ;I
- New Walidation node has been added to Validation.
=
Configure validation plots. 4

f Click Show Plots.

This action opens the following figures:

® New Validation - Plot 1 (Measured and simulated): Displays

the validation data and simulated response.

® New Validation - Plot 2(Residuals): Displays the difference

between the measured data and simulated response.

3 Examine the simulated response plot to see how well the simulated output

matches the validation data.



Validating Estimated Model Parameters

The simulated response, as shown in blue on the New Validation - Plot
1 (Measured and simulated) plot, is overlaid on the measured output
data, and closely matches the measured data Validation Data 1.

) New Yalidation - Plot 1 {Measured and simulated) : i |

File Edit Yiew Insert Tools Desktop ‘Window Help a
NEEdS [ [RRATDE £ 2|0 ad

Measured vz, Simulated Responses

Validation Data 1
100 T T T T T T T T T

Amplitude
Position

10 L L L 1 1 1 L 1 1
1] 005 0.1 015 0z 0.25 03 0.35 0.4 0.45

Time (sec)

4 Examine the residuals plot to compare the difference between the
simulated response and measured data.

The difference between the simulated and measured data, as shown in the
New Validation - Plot 2(Residuals) plot, varies between 2 and -2.5.
The residuals lie within 6% of the maximum output variation, and do not
display any systematic patterns. This indicates a good fit between the
simulated output and measured data.
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) New Validation - Plot 2 {Residuals) : = |EI|5|

File Edit ‘iew Insert Tools Deskbop  Window  Help o
i3 =) L (=)
Residuals
Validation Data 1
25 T T T T T T T T T
2 L -
15F E
1 [ -
05 E
e 5
B2 o :
w o
o
05 E
-1
15F |l
2 L
_25 1 1 1 1 1 1 1 1 1

a 005 0.1 015 02 0.25 03 0.35 04 0.45
Time (sec)

5 Save the Control and Estimation Tools Manager project.

a In the Control and Estimation Tools Manager GUI, select File > Save.

This action opens the Save Projects dialog box.
b In the Save Projects dialog box, click OK.

¢ In the Save Projects window, specify the name of the project in the File
name field, and click Save.

This action saves the project as a MAT-file.
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Tip You can load a project by selecting File > Load in the Control and
Estimation Tools Manager GUI. To view the estimated parameter values,
select the Parameters tab of New Estimation node.

6-31



6 Tuiorial — Estimating Parameters from Measured Data Using the GUI

6-32



Tutorial — Optimizing
Parameters to
Meet Time-Domain

Requirements Using the
GUI

“About This Tutorial” on page 7-2

“Configuring a Model for Optimizing Parameters” on page 7-5

® “Optimizing Model Parameters to Meet Step Response Requirements” on
page 7-8

“Refining Model Parameters to Track a Reference Signal” on page 7-25

“Saving the Project” on page 7-31
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About This Tutorial

In this section...

“Objectives” on page 7-2
“About the Model” on page 7-2

“Design Requirements” on page 7-4

Obijectives

In this tutorial, you learn how to use the GUI to optimize the parameters of a
Simulink model to meet time-domain design requirements.

You accomplish the following tasks using the GUI:

® Specify step response requirements on the model’s output.
® Specify a reference signal for the model’s output to track.

® Optimize and refine the parameters to meet the design requirements.

Tip To learn how to optimize model parameters to meet time-domain design
requirements using command line functions, see Chapter 8, “Tutorial —
Optimizing Parameters to Meet Time-Domain Requirements Using the
Command Line”.

About the Model

In this tutorial, you use the Simulink model named sldo_model1, as shown in
the next figure.




About This Tutorial

=
File Edit WView Simulaton Format Tools Help
NESEHS| $B2R|E= 4=y =po | Nom =l R e
n + FID o In Out1
Unit Step
Controller Flant
Ready [100%% [ |ode4s Y

Tip To open the model, type sldo_modeli at the MATLAB command prompt.

The model contains a Controller block, which is a PID controller. This block
controls the output of the Plant subsystem. The Unit Step block applies
a step input to the system.

Note This tutorial uses a step input to produce the model’s response and
optimize the model parameters to meet step response requirements. You can
also use other types of inputs, such as ramp, and optimize parameters to meet
requirements on the model’s response to these inputs.

Double-click the Plant subsystem to open it. The plant is a second-order
system with delay. It contains Transfer Function and Transport Delay blocks,
as shown in the next figure.
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7] sido_model1/Plant - O] x|

File Edit View Simulaton Format Tools Help

DS H&| % BR|E= 4|22 » =

(T —m — w 0 (T

In1 2w retas+win2

Transport Delay
Transfer Fon

Ready [100% | | lode45 Y

To learn more about the blocks, see Transfer Fen and Transport Delay block
reference pages.

Design Requirements

The model’s output must meet the following design requirements:
® (QOvershoot less than 10%

® Rise time less than 10 seconds

® Settling time less than 30 seconds

® Track a reference signal specified by 1-e(-0.3*t), where t is time



Configuring a Model for Optimizing Parameters

Configuring a Model for Optimizing Parameters

In this portion of the tutorial, you configure a Simulink model for optimizing
parameters:

1 Open the s1ldo_modell1 model, if it is not already open, by typing the model
name at the MATLAB prompt:

sldo_modelf

The Simulink model opens, as shown in the next figure.

7] sido_model1 i =] B

File Edit Wiew Simulaton Format Tools Help

D|@ﬂ§|é€ﬂ|<}==ﬁ>{r|fﬁe|b IIE-D.D INorrnaI j|

!i____:::!IF——————P FID

Unit Step

Out1

Y

Controller Plant

Ready [100%% [ | |ode4s 4

To learn more about the model, see “About the Model” on page 7-2.

2 Add a Signal Constraint block to the model.

a In the Simulink model, select View > Library Browser to open the
Simulink Library Browser.



7 Tutorial — Optimizing Parameters to Meet Time-Domain Requirements Using the GUI

7-6

b In the Libraries pane, select Simulink Design Optimization.

=] simulink Library Browser

File Edit View Help

i [m [

|

= = I

Libraries

i O IO oy IO o O

RF Blockset

Real-Tims Windows Target

Real-Time Workshop

Real-Time Workshop Embedded Coder

Report Generator

Robust Control Toolbox

Signal Processing Blockset

SimEvents

SimPowerSystems

Simzcape

Simulink 30 Animation

Simulink Control Design
mulink Design Op

Simulink De=ign Verifier

Simulink Extras

Simulink Werification and Validation
Stateflow

Showing: Simulink Design Optimization

[

Library: Simulink Design Optimization I Search Resultz: (nonej

@ Adaptive Lockup Tables

Demsz

RMS Blods

Signal Constraint

(7 E

¢ Drag and drop the Signal Constraint block into the Simulink model

window.

To learn more about the block, see the Signal Constraint block reference

page.



Configuring a Model for Optimizing Parameters

d Connect the Signal Constraint block to the model’s output, as shown in
the next figure.

=T
File Edit View Simulation Format Tools Help

DEeES| 2R8> 4|22 » =ko  [m =R RE R

“ FID p!int Out
Unit Step -
Contraller Flant
Signal Constraint

Ready 100% |ode4s v

Note You must connect the Signal Constraint block to the signal

to which you want to add design requirements. To learn more, see
“Choosing Signals to Constrain” in the Simulink Design Optimization
User’s Guide.
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Optimizing Model Parameters to Meet Step Response
Requirements

In this section...

“Specify Time-Domain Design Requirements” on page 7-8
“Specifying Parameters to Optimize” on page 7-18

“Optimizing the Parameters” on page 7-21

Specify Time-Domain Design Requirements
In this portion of the tutorial, you specify the rise time, setting time and
overshoot requirements that the model’s response should satisfy.

You must have already configured the Simulink model, as described in
“Configuring a Model for Optimizing Parameters” on page 7-5.

To specify the design requirements:



Optimizing Model Parameters to Meet Step Response Requirements

1 Double-click the Signal Constraint block to open the Block Parameters:
Signal Constraint window.

) Block Parameters: Signal Constraint -3 x|
File Edit Plots Goals Optimization Help
SHe |/ =2
Input to sldo_model _constrilkiSignal Constraint
1.2 o o ]
P e P
Og k-
z 3
z [iY-) SR
=
E 04
02kt
(i) .
-0.2
u] | 10 15 20 25 30 35 40 45 a0
Time (sec)
¥ Enforce signal bounds [~ Track reference signal

Tip To view the line segment that extends from 0 to 15 seconds, set the
upper limit of the Amplitude axis to 1.3. To do so, right-click in the plot,
and select Axes Limits.
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The Block Parameters window shows an amplitude versus time plot. The
line segments map to the step response requirements shown in the next
figure.

12 " "
% Qvershootg

. S .

Y S ]

8 10 12 14 16 13 20

Rise time Settling time

By default, the line segments represent the following step response
requirements:

¢ Amplitude less than or equal to —0.01 up to the rise time of 5 seconds for
1% undershoot

¢ Amplitude between 0.9 and 1.2 up to the settling time of 15 seconds

¢ Amplitude equal to 1.2 for 20% overshoot up to the settling time of 15
seconds

¢ Amplitude between 0.99 and 1.01 beyond the settling time for 2% settling
To specify the design requirements described in “Design Requirements”

on page 7-4, you must modify the time and amplitude values of the line
segments, as described in the next steps.



Optimizing Model Parameters to Meet Step Response Requirements

2 Double-click the lower yellow region shown on the plot.

This action opens the Edit Design Requirement dialog box, as shown in
the following figure.

) Edit Design Requirement =10 x|

Design reguirement: Ianer time response bound from 0to 50 sec ;I

—Design requirement parameters

Segments:
Skart End

Time Amplitude Time Amplitude Slope Weight
0 -0.0100 5 -0.0100 0 1|
5 0.9000 15 0.9000 0 1
15 0.9200 50 0.9200 0 1 ;I
Insert | Delete |

The rows in the dialog box define the lower bound on the signal. The time
span, displayed in the Design requirement drop-down list, is same as the
simulation time specified in the Simulink model.

The rows correspond to the following three line segments in the Block
Parameters window:

® First row — Lower-line segment that extends from 0 to 5 seconds.
® Second row — Lower-line segment that extends from 5 to 15 seconds.

® Third row — Lower-line segment that extends from 15 to 50 seconds.

The default amplitude and time values specified in the rows appear in the
Block Parameters window, as shown in the next figure.
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0.8 Fereeeed

Amplitude
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02

a | 10 15 20 25
Time [zec)

3 Specify the rise time requirement:

a In the first row of the Edit Design Requirement dialog box, double-click
the Time field in the End column.

b Type 10, and press Enter.

The first row now looks like the following figure.

Start End
Time Amplitude Time Amplitude Slope Weight
4] -0.0100 -0.0100 4] 1| =

This action also updates the Block Parameters window to show the rise
time requirement. This requirement is represented by the line segment
at the bottom left of the window that extends from 0 to 10 seconds, as
shown in the next figure.



Optimizing Model Parameters to Meet Step Response Requirements

) Block Parameters: Signal Constraint - ol =l

File Edit Plots Goals Optimization Help
SHe R =2

Input to sldo_model _constrilkiSignal Constraint

o
<
£
=4
E 04

(7] SRR

0k
-0.2
u] | 10 15 20 25 30 35 40 45 a0
Time (seC)

¥ Enforce signal bounds [~ Track reference signal

4 Specify the settling time requirement:

a In the second row of the Edit Design Requirement dialog box,
double-click the Time field in the End column.
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b Type 30, and press Enter.

The second row looks like the following figure.

Start End
Time Amplitude Time Amplitude Slope Weight
[ 4] -0.0100 10 -0.0100 1 (=
[ 10 0.,9000 0,9000 1

This action also updates the Block Parameters window to show the
settling time requirement on the lower bound. This requirement is
represented by the line segment that extends from 10 to 30 seconds, as

shown in the next figure.

) Block Parameters: Signal Constraint

Fil= Edit Ploks Goals Optimization Help

=101 %]

GHe|RRE[r = |2

Input to sldo_model! _constrblkiSignal Constraint

Amplitude

1] 5 10 15 20 25 30 5
Time (sec)
[+ Enforce signal bounds [~ Track reference signal

40
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¢ In the Edit Design Requirements dialog box, select Upper time
response bound from 0 to 50 sec in the Design Requirement
drop-down list.

RICIE

Design reguirement:

Upper time

~Design requirement parameters

Segments:
Start End
Time Amplitude Time Amplitude Slope Weight
0 1.2000 15 1.2000 4] 1
15 1.0100 50 1.0100 4] 1

Insert | Delete |

Close | Help |

The rows in the dialog box define the upper bound on the signal, and
correspond to the following two line segments in the Block Parameters
window:

¢ First row — Upper-line segment that extends from 0 to 15 seconds.

¢ Second row — Upper-line segment that extends from 15 to 50 seconds.

The default amplitude and time values specified in the rows appear in
the Block Parameters window, as shown in the next figure.

Amplitucde

a 5 10 15 20 25
Time (sec)
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d In the first row, double-click the Time field in the End column.
e Type 30, and press Enter.

The first row looks like the following figure.

Skart End
Time Amplitude Time Amplitude Slope Weight
4] 1.2000 1.2000 0 1

This action also updates the Block Parameters window to show the
settling time requirement on the upper-bound. This requirement is
represented by the line segment that extends from 0 to 30 seconds, as
shown in the next figure.

) Block Parameters: Signal Constraint -0 LI

File Edit Plots Goals Optimization Help
Sde (SR E[r =2

Input to sldo_model _constrblkfSignal Constraint

Amplitude

0 b
0.2

-02
o 5 10 15 20 25 30 35 40 45 =0

Time [sec)
[¥ Enforce signal bounds [ Track reference signal

5 Specify the overshoot requirement:

a In the Edit Design Requirement dialog box, verify that Upper time
response bound from 0 to 50 sec is selected in the Design
Requirement drop-down list.

b In the first row, double-click the Amplitude field in the Start column.
¢ Type 1.1, and press Enter.
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d Double-click the Amplitude field of the End column.
e Type 1.1, and press Enter.

The first row now looks like the following figure.

Start End
Time Amplitude Time Amplitude Slape Weight
0 1,1000 20 il

The Block Parameters window updates to show the overshoot
requirement. This requirement is represented by the amplitude value of
1.1 for the line segment that extends from 0 to 30 seconds, as shown in
the following figure.

) Block Parameters: Signal Constraint - 3]
File Edit Plots Goals Optimization Help

e (R E[r 8|2

Input to sldo_model _constrilkiSignal Constraint

Amplitude

0 b

-02
o 5 10 15 20 25 30 35 40 45 =0

Time [sec)
[¥ Enforce signal bounds [ Track reference signal

When you optimize the model parameters, the model’s final response
must lie in the white region bounded by the line segments in order to
meet the design requirements.

6 In Edit Design Requirement dialog box, click Close.

7-17



7 Tutorial — Optimizing Parameters to Meet Time-Domain Requirements Using the GUI

Specifying Parameters to Optimize

In this portion of the tutorial, you specify the model parameters to optimize.
When you optimize the model parameters, the software modifies the
parameter values to meet the specified design requirements.

Before you specify the parameters to optimize, you can specify the design
requirements, as described in “Specify Time-Domain Design Requirements”
on page 7-8.

To specify the parameters to optimize:

1 In the Block Parameters window, select Optimization > Tuned
Parameters.

This action opens the Tuned Parameters dialog box.

} Tuned Parameters =10 x|
— Tuned parameters ———  — Optimization Setting:
LI Mame:
WallE:
Initial guess: |
Iinitmuirm: |
hidaimuim: |
Typical value: |
I~ Tuned
Referenced by:
=]
=
Add... | Dekete | =l
ok | cancel| Hew |
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2 In the Tuned Parameters window, click Add.

This action opens the Add Parameters dialog box.

=

Zelect workspace variables:

Hd ;|
i

K

wil

zeta

=
Specify expression (e.g., =.x or a3

0K I Cancell Help I
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3 In the Add Parameters dialog box, select the PID controller parameters
Kd, Ki and Kp, and click OK.

This action adds Kd, Ki and Kp to the Tuned Parameters window.

~i0ix
— Tuned parameters ———  — Optimization Setting:
K “alue: 0
Imitial guess: kd
hdinitnuirm: |-Inf
MM Int
Typical value: kd
v Tuned

Referenced by:
Controller d

]

QK I Cancell Help |

The Optimization Settings area displays the following parameter
settings:

¢ Value — Current parameter value

¢ Initial Guess — Initial parameter value

¢ Minimum and Maximum — Parameter bounds

¢ Typical Value — Scaling factor for the parameter

To learn more about the parameter settings, see “Changing Tuned

Parameter Specifications” in the Simulink Design Optimization User’s
Guide.
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4 To limit the parameters to positive values, enter the minimum value of

each parameter as 0 in the corresponding Minimum field.

After you enter these values, the Tuned Parameters window resembles

the next figure.

) Tuned Parameters =] 3]
— Tuned parameters - — Optimization Setting
Eld LI Mame: ata]
Kp alLe: 1
Initial guess: }(p
dinimuirm; E
hacimuim: lm’
Typical walue: }(p
v Tured
Referenced by:
Controller d
|
Add... | Delete | =l
OK | Cancel | Help I

5 Click OK to apply the parameter settings and close the Tuned Parameters

window.

Optimizing the Parameters

In this portion of the tutorial, you optimize the model parameters to meet

the specified design requirements.

You must have already specified the design requirements and the parameters
to optimize, as described in “Specify Time-Domain Design Requirements” on
page 7-8, and “Specifying Parameters to Optimize” on page 7-18, respectively.

To optimize the model parameters:
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1 In the Block Parameters window, click Optimization > Start to start
the optimization.

This action opens the optimization progress window as shown in the next

figure.
) Optimization Progress i =] 9]
max Directional First-order
Iter S-count £ix) constraint SEEp-Siae derivacive optimality
u} 1 a 207.1
dl | [

¢ During each optimization iteration, the software simulates the model,
and the default optimization algorithm Gradient descent modifies the
controller parameters to reduce the distance between the simulated
response and the design requirement line segments. To learn more about
the optimization algorithm, see “Selecting Optimization Methods” in the
Simulink Design Optimization User’s Guide.
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e After the optimization completes, the Optimization Progress window

resembles the next figure.

) Optimization Progress

max

Iter S—count £ix) constraint
a 1 o 207.1
1 14 o 3.787
2 21 o 0.4841
3 28 -9.19412e-020 WS o P B

=1 35
Successful termination.

o a
Found a feasible or optimal solution within
Kd

0.04&8

0.1455

Ep =

0.18353

|

Directional First-order

Step-size derivative optimality Procedure

1.25 u} 1 infeasible
0S4 u} £.18
0.0755 -1.22e-018 0.000891
0.0233 3.95e-018 0.000114 Hessian modified

the specified tolerances.

of

The message Successful termination indicates that the optimization
algorithm found a solution that meets the design requirements within
the parameter bounds. For more information about the outputs
displayed in the optimization progress window, see “Displaying Iterative
Output” in the Optimization Toolbox documentation.

The optimized parameter values are displayed in the Optimization

Progress window, and also written

into the Simulink model.

2 In the Block Parameters window, examine the model’s response to see if
the response meets the step response requirements.

The final response of the system with the optimized parameter values
appears in black, as shown in the next figure.
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) Block Parameters: Signal Constraint =10l x|

File Edit Plots Goals Optimization Help
—Fjlﬂ'é|+\-_‘\-@|'.|§

It to optim_model1 $Signal Constesint

Amplitude

-02
[t} 5 10 15 20 25 30 39 40 435 S0

Time (sec)
[V Enforce signal bounds [~ Track reference signal

The plot also displays the initial response of the system in blue. The
remaining responses show the simulated response at each optimization

iteration.

The optimized response of the system lies in the white region bounded
by the design requirement line segments and thus meets the specified
requirements.

Next, you refine the model parameters by specifying a reference signal
that the system response must track, as described in “Refining Model
Parameters to Track a Reference Signal” on page 7-25.
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Refining Model Parameters to Track a Reference Signal

In this portion of the tutorial, you optimize the model parameters to track a
reference signal specified by the equation

y =1-exp(-0.3x¢)

You must have already optimized the model parameters to meet the step
response requirements, as described in “Optimizing Model Parameters to
Meet Step Response Requirements” on page 7-8.

To optimize the parameters to track a reference signal:

1 In the Block Parameters window, select Goals > Desired Response.
This action opens the Desired Response dialog box.

_iEix

{* Specify reference signal

{~ Specify step response characteristics

— Reference signal

Tirme wectar; |

Amplitude: I

OK | Cancel Help Apply

2 Specify the reference signal:
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a In the Time vector field of the Desired Response dialog box, enter
linspace(0,50,200).

b In the Amplitude field, enter 1-exp(-0.3*1inspace(0,50,200)).

After you make these changes, the Desired Response dialog box
resembles the following figure.

I x]

{+ Specify reference signal

{~ Specify step response characteristics

— Reference signal

Time wector: Jinspace(0,50,200)

Amplitude: [l -pxp(-0.3linspace(0 50,200))

OK Cancel Help Apply
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¢ Click OK to add the reference signal to the block and close the Desired
Response dialog box.

The Block Parameters window updates to display the reference signal,

shown as the gray dashed curve, in the next figure.

) Block Parameters: Signal Constraint -10] x|
File Edit Plots Goals Optimization Help

jﬂé|+\_\g|}.|§

Input to zldo_model $Signal Constraint

Amplitude

o S 10 15 20 25 30 35 40 45 a0
Time (=ec)

[¥ Enforce signal bounds [ Track reference signal

3 In the Block Parameters window, select the Track reference signal
check box.

[V Enforce signal bounds W Track reference signal
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4 In the Signal Constraint block window, select Optimization > Start to
start the optimization.

This action restarts the optimization using the optimized parameters
values computed in “Optimizing Model Parameters to Meet Step Response
Requirements” on page 7-8. The Optimization Progress window opens,

as shown in the next figure.

) Optimization Progress i =] 9]

max Directional First-order

Iter S-count £ix) constraint SEEp-Siae derivacive optimality
u} 1 21547 a

< | I~
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® At each iteration, the optimization algorithm modifies the controller
parameters to minimize the error between the simulated response and
the reference signal. Simultaneously, the algorithm satisfies the step
response requirements by reducing the distance between the simulated
response and the design requirement line segments.

® After the optimization completes, the Optimization Progress window
resembles the following figure.

il x|
max Directional First-order :J
Iter S-count £ix) constraint Step-size derivative optimality Procedure
u] 1 2.1547 a
1 20 0.561528 0.0z2738 0.822 —-7.04 74
2 36 B3B3 23 0.03301 0.142 —alieh 1.84
3 2= 0.360718 a 0.296 =D BEZ 3.3
= &0 B. 271571 a O 173 —0.84 2.69
5 71 0.173588 a o321 -0.4&8 1.76
B 82 0.1574 a s ) SHZES 1.28
T =hl 0.1468542 a . e -D.168 H-BZ4
=] 100 0.139&88 a [l -0.208 0.37
9 102 s ki Ll a 0.0185 SBZEg 0.102
10 116 0.133726 o 0.0Z5& =0 O7ds 0.109

Optimization terminated dus to slow progress in parameter or objectiwve walues.
To optimize further, go to Optimization Options and decrease the parameter and/or
function tolerances.

Ed =

1.5821

Ki =

0.287&

Ep =

0. 6311 —

=l

The message, Optimization terminated due to slow progress in
parameter or objective values appears in the Optimization Progress
window. This message indicates that the optimization algorithm cannot
minimize the error between the simulated response and the reference
signal any further. You must examine the optimized response of the
model to check if the response tracks the reference signal, as described
in the next step.
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5 In the Block Parameters window, examine the model’s response to see how
well the response tracks the reference signal.

The model’s response before you began the optimization appears as the
blue curve. After the optimization completes, the final response, shown as
the black curve, tracks the reference signal.

) Block Parameters: Signal Constraint = |E||1|

File Edit Plots Goals Optimization Help
da A r =2

Input to sldo_model iSignal Constraint

Amplituice

-0.2
0 5 10 15 20 25 30 35 40 45 50
Time (sec)

[ Enforce signal bounds [ Track reference signal

Note To refine the parameters further to track the reference signal more
closely, change the parameter and function tolerances, as described in
“Selecting Optimization Termination Options” in the Simulink Design

Optimization User’s Guide.
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Saving the Project

After you optimize the model parameters, you can save the model with
the design requirements and optimized parameter values in a response
optimization project.
To save a response optimization project:
1 In the Signal Constraint block window, select File > Save As.

This action opens the Save Project dialog box.

IRTEY

Save optimization praoject as:

{* MATLAB workspace variakble:
Isldc-_mndeH _final_optim

= Model workspace variable:

Isl-:l-:u_m-:n-:leﬂ _final_optim

= MAT-file:
Isl-:l-:u_m-:u-:leﬂ _final_optim mat il

v Save and reload project with Simulink model

OK I Cancell Help

2 In the Save Project dialog box, select the Model workspace variable
option, and enter a variable name.

3 Click OK to save the project.

Tip You can load the response optimization project by loading the Simulink
model.
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Tutorial — Optimizing
Parameters to

Meet Time-Domain
Requirements Using the
Command Line

e “About This Tutorial” on page 8-2
e “Configuring a Model for Optimizing Parameters” on page 8-5

® “Optimizing Model Parameters to Meet Step Response Requirements” on
page 8-8

® “Refining Model Parameters to Track a Reference Signal” on page 8-15
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About This Tutorial

In this section...

“Objectives” on page 8-2
“About the Model” on page 8-2

“Design Requirements” on page 8-4

Obijectives

In this tutorial, you learn how to use Simulink Design Optimization functions
to optimize the parameters of a Simulink model to meet time-domain design
requirements.

You accomplish the following tasks using the command line:

® Specify step response requirements on the model’s output.
® Specify a reference signal for the model’s output to track.

® Optimize the parameters to meet the design requirements.

Tip To learn how to optimize model parameters to meet time-domain
design requirements using the GUI, see Chapter 7, “Tutorial — Optimizing
Parameters to Meet Time-Domain Requirements Using the GUI”.

About the Model

In this tutorial, you use the Simulink model named sldo_model1, as shown in
the next figure.



About This Tutorial

=
File Edit WView Simulaton Format Tools Help
NESEHS| $B2R|E= 4=y =po | Nom =l R e
n + FID o In Out1
Unit Step
Controller Flant
Ready [100%% [ |ode4s Y

Tip To open the model, type sldo_modeli at the MATLAB command prompt.

The model contains a Controller block, which is a PID controller. This block
controls the output of the Plant subsystem. The Unit Step block applies
a step input to the system.

Note This tutorial uses a step input to produce the model’s response and
optimize the model parameters to meet step response requirements. You can
also use other types of inputs, such as ramp, and optimize parameters to meet
requirements on the model’s response to these inputs.

Double-click the Plant subsystem to open it. The plant is modeled as a
second-order system with delay. It contains Transfer Function and Transport
Delay blocks, as shown in the next figure.
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7] sido_model1/Plant - O] x|

File Edit View Simulaton Format Tools Help

DS H&| % BR|E= 4|22 » =

(T —m — w 0 (T

In1 2w retas+win2

Transport Delay
Transfer Fon

Ready [100% | | lode45 Y

To learn more about the blocks, see Transfer Fcn, and Transport Delay block
reference pages.

Design Requirements

The models’ output must meet the following design requirements:

® Overshoot less than 10%
® Rise time less than 10 seconds
® Settling time less than 30 seconds

¢ Track a reference signal specified by y=1-exp(-0.3x?) , where t is time
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Configuring a Model for Optimizing Parameters

To optimize parameters of a Simulink model, you must first configure the
model:

1 Open the s1ldo_modell1 model, if it is not already open, by typing the model
name at the MATLAB prompt:

sldo_modelf

The Simulink model opens, as shown in the next figure.

7] sido_model1 i =] B

File Edit Wiew Simulaton Format Tools Help

DEHS| & 28 4 (2 b =50 | [Nomal | ®

FID

Unit Step

Out1

Y

Controller Plant

Ready [100%% [ | |ode4s 4

To learn more about the model, see “About the Model” on page 8-2.

2 Add a Signal Constraint block to the model.

a In the Simulink model, select View > Library Browser to open the
Simulink Library Browser.
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b In the Libraries pane, select Simulink Design Optimization.

=] simulink Library Browser

File Edit View Help

i [m [

|

= = I

Libraries

i O IO oy IO o O

RF Blockset

Real-Tims Windows Target

Real-Time Workshop

Real-Time Workshop Embedded Coder

Report Generator

Robust Control Toolbox

Signal Processing Blockset

SimEvents

SimPowerSystems

Simzcape

Simulink 30 Animation

Simulink Control Design
mulink Design Op

Simulink De=ign Verifier

Simulink Extras

Simulink Werification and Validation
Stateflow

Showing: Simulink Design Optimization

[

Library: Simulink Design Optimization I Search Resultz: (nonej

@ Adaptive Lockup Tables

Demsz

RMS Blods

Signal Constraint

(7 E

¢ Drag and drop the Signal Constraint block into the Simulink model

window.

To learn more about the block, see Signal Constraint block reference

page.
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d Connect the Signal Constraint block to the model’s output, as shown in
the next figure.

=T
File Edit View Simulation Format Tools Help

DEeES| 2R8> 4|22 » =ko  [m =R RE R

“ FID p!int Out
Unit Step -
Contraller Flant
Signal Constraint

Ready 100% |ode4s v

Note You must connect the Signal Constraint block to the signal

to which you want to add design requirements. To learn more, see
“Choosing Signals to Constrain” in the Simulink Design Optimization
User’s Guide.
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Optimizing Model Parameters to Meet Step Response
Requirements

In this portion of the tutorial, you use Simulink Design Optimization
commands to optimize the model parameters to meet step response
requirements.

You must have already configured your model for optimization, as described
in “Configuring a Model for Optimizing Parameters” on page 8-5.

To optimize the model parameters to meet step response requirements:

1 Create a new project using the newsro command.
proj=newsro('sldo_modeli',{'Kd','Ki','Kp'})

This command creates a new project object, proj, that contains instructions
to optimize the parameters Kp, Ki, and Kd.

Name: 'sldo_modell’
Parameters: [3x1 ResponseOptimizer.Parameter]
OptimOptions: [1x1 sroengine.OptimOptions]
Tests: [1x1 ResponseOptimizer.SimTest]
Model: 'sldo_modeld'

Response Optimization Project.

2 Retrieve the signal constraint object for the project, proj, using the
findconstr command.

constr=findconstr(proj, 'sldo_model1/Signal Constraint')

This command retrieves the following signal constraint object:

ConstrEnable: 'on'
isFeasible: 1
CostEnable: 'off'
Enable: 'on'
Name: 'Signal Constraint'
SignalSize: [1 1]
LowerBoundX: [3x2 double]
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LowerBoundY:
LowerBoundWeight:
UpperBoundX:
UpperBoundY:
UpperBoundWeight:
ReferenceX:
ReferenceY:
ReferenceWeight:

Signal Constraint.

[3x2 double]
[3x1 double]
[2x2 double]
[2x2 double]
[2x1 double]
[]
[]
[]

The LowerBoundX, LowerBoundY, UpperBoundX, and UpperBoundY
properties of the constr object represent the numeric values of design

requirements on a signal.

Tip You can view the default design requirements by double-clicking the
Signal Constraint block in the sldo_model1 Simulink model.

The LowerBoundX, and LowerBoundY properties define the lower bound, and
the UpperBoundX and UpperBoundY define the upper bound on the signal.
These properties are matrices, whose elements represent the values of the
bounds as shown in the following table.

Property Name

Purpose

LowerBoundX Time values of the lower-bound line
segments

LowerBoundY Amplitude values of the
lower-bound line segments

UpperBoundX Time values of the upper-bound
line segments

UpperBoundY Amplitude values of the

upper-bound line segments
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For example, the elements of the LowerBoundX, and LowerBoundY matrices
map to the following values.

Time of all lower
design requirement
line segments

Time of beginning
point of first
line segment

Time of end

Iipoint of first
- line segment

lxyy lx,,

J_

Time of beginning
and end points of
second line segment

Amplitudes of all lower
design requirement
line segments

Amplitude of beginning
point of first line segment

Amplitude of end

oint of first line
| - segment

Iygy Iy

'+

—
LowerBoundY =| ly,, ly 5

Amplitude of beginning
and end points of second
line segment

r
LowerBoundX = fxb2 '{Tez

f.‘fbg lx E}'bg '{yeg .

ed =

Amplitude of beginning
and end points of third
line segment

Time of beginning
and end points of
third line segment

The line segments that correspond to the elements of LowerBoundX, and
LowerBoundY matrices appear in the next figure.
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Similarly, the elements of UpperBoundX and UpperBoundY map to the time
and amplitude values of the upper-bound line segments, respectively.

To specify the step response requirements, as described in “Design
Requirements” on page 8-4, you must edit these properties as shown in
the next step.

Note When you add or modify design requirements using functions, the
Block Parameters window does not update to display the new requirements.

To view the values of the LowerBoundY matrix, type the following command:
constr.LowerBoundY
3 Specify the step response requirements using the following commands:

% Rise time requirement

constr.LowerBoundX=[0 10;10 15;15 50];

% Settling time requirement on lower line segments;
constr.LowerBoundX=[0 10;10 30;30 50];

% Settling time requirement on upper line segments
constr.UpperBoundX=[0 30;30 50];

% Overshoot requirement on upper bound
constr.UpperBoundY=[1.1 1.1;1.01 1.01];

Tip You can type constr.PropertyName to view the updated values of
the properties.

4 Specify the parameters to optimize:

a Retrieve the vector of parameter objects from the project object, proj,
using the findpar command.

param(1)=findpar(proj, 'Kd");
param(2)=findpar(proj, 'Ki');
param(3)=findpar(proj, 'Kp');

b To view the properties of a parameter object, type the object name. For
example:
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param(1)

This command returns the properties of param(1) object.

Name:

Value:
InitialGuess:
Minimum:
Maximum:
TypicalValue:
ReferencedBy:
Description:
Tuned:

Tuned parameter.

'Kd'
0

0

-Inf

Inf

0

{0x1 cell}

1

¢ To limit the parameter to positive values, enter the minimum value for
each parameter as 0 using the following commands:

param(1).Minimum=0;
param(2) .Minimum=0;
param(3) .Minimum=0;

Tip To view the updated value of the Minimum property for Kd, type

param(1).Minimum.

5 Optimize the parameters using the optimize command:

opt=optimize(proj)

This command returns the following results:

Iter S-count f(x)
0 1 0
1 14 0
2 21 0
3 28 -9.19412e-020
4 35 0

max Directional First-order
constraint Step-size derivative optimality Procedure
207.1
3.767 1.25 0 1 infeasible
0.4641 0.541 0 6.18
0.02942 0.0755 -1.22e-018 0.000891
0 0.0233 3.95e-018 0.000114 Hessian modified



Optimizing Model Parameters to Meet Step Response Requirements

Successful termination.

Found a feasible or optimal solution within the specified tolerances.
Kd =

0.0468

Ki =

0.1455

Kp =

0.1853

ans =

Cost: 0O
X: [4x1 double]
ExitFlag: 1

Iteration: 4

® At each optimization iteration, the software simulates the model and
the default optimization algorithm Gradient descent modifies the
controller parameters to reduce the distance between the simulated
response and the design requirements. To learn more about the
optimization algorithm, see “Selecting Optimization Methods” in the
Simulink Design Optimization User’s Guide.

® After the optimization completes, you see the messages Successful
termination, and ExitFlag:1 at the MATLAB prompt. These messages
indicate that the optimization algorithm found a solution that meets the
design requirements within the parameter bounds. For more information
about the outputs displayed during the optimization, see “Displaying
Iterative Output” in the Optimization Toolbox documentation.

The optimized values of the parameters, Kp, Ki and Kd, are displayed at
the command line, and are also written into the Simulink model.
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Next, you refine the parameters by specifying a reference signal, as described
in “Refining Model Parameters to Track a Reference Signal” on page 8-15.
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Refining Model Parameters to Track a Reference Signal

In this portion of the tutorial, you optimize the model parameters to track a
reference signal specified by the equation

y =1-exp(-0.3x¢)

You must have already optimized the model parameters to meet the step
response requirements, as described in “Optimizing Model Parameters to
Meet Step Response Requirements” on page 8-8.

To optimize the parameters to track a reference signal:

1 Specify the reference signal to track using the following commands:

[)

% Enable reference tracking

constr.CostEnable='on';

% Specify the time values of the reference signal
constr.ReferenceX=1linspace(0,50,200)"';

% Specify the amplitude values of the reference signal
constr.ReferenceY=1-exp(-0.3*1linspace(0,50,200))";

Tip To verify that the reference signal has been added to the signal
constraint object, type constr=findconstr(proj,'sldo_model1/Signal
Constraint'). The ReferenceX and ReferenceY properties now contain
the reference signal.

2 Initialize the parameters in proj for optimization.

a Set the initial guess of the parameters using the initpar command.

% Copy parameter values from Simulink model to the project
initpar(proj)

b Update the scaling factor of the parameters with the initial parameter
values using the following commands.

% Update scaling factor with the initial parameter value
param(1).TypicalValue = param(1).InitialGuess;
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param(2).TypicalValue = param(2).InitialGuess;
param(3).TypicalValue param(3).InitialGuess;

To learn more about the scaling factor, see “Changing Tuned Parameter
Specifications” in the Simulink Design Optimization User’s Guide.

When you optimize the model parameters after this initialization, the
optimization algorithm uses the updated parameter settings to recompute
new parameter values.

3 Start the optimization using the optimize command.
opt=optimize(proj)

This command returns the following results:

max Directional First-order
Iter S-count f(x) constraint Step-size derivative optimality Procedure
0 1 2.1547 0

1 20 0.561528 0.02738 0.622 -7.04 74
2 36 0.438343 0.03301 0.142 -1.13 1.84
3 49 0.360718 0 0.296 -0.802 3.3
4 60 0.271571 0 0.173 -0.64 2.69
5 71 0.178588 0 0.321 -0.468 1.76
6 82 0.1574 0 0.147 -0.215 1.28
7 91 0.146542 0 0.0941 -0.168 0.824
8 100 0.139688 0 0.0443 -0.208 0.37
9 109 0.135451 0 0.0185 -0.294 0.102
10 116 0.133726 0 0.0256 -0.0779 0.109

Optimization terminated due to slow progress in parameter or objective values.
To optimize further, go to Optimization Options and decrease the parameter and/or

function tolerances.

1.5821

0.2876

Kp =
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0.6311

ans =

Cost: 0.1337
X: [4x1 double]
ExitFlag: 5

Iteration: 10

e At each iteration, the optimization algorithm modifies the controller
parameters to minimize the error between the simulated response and
the reference signal. Simultaneously, the algorithm satisfies the step
response requirements by reducing the distance between the simulated
response and the design requirement line segments.

¢ After the optimization completes, you see the message Optimization
terminated due to slow progress in parameter or objective
values. This message indicates that the optimization algorithm cannot
minimize the error between the simulated response and the reference
signal any further. If you want to refine the parameters further to track
the reference signal more closely, change the parameter and function
tolerances, as described in “Selecting Optimization Termination Options”
in the Simulink Design Optimization User’s Guide.

Tip To view the updated response of the model, connect a Scope block to
the model and simulate the model to view the response.

4 Save the project by typing the following command:

save('proj');
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“About This Tutorial” on page 9-2

“Configuring a Project for Optimization-Based Control Design” on page 9-5

® “Designing an Initial PID Controller to Meet Bode Magnitude and Phase
Margins Requirements” on page 9-11

e “Refining the Controller Design to Meet Controller Output Bounds” on
page 9-32

“Saving the Project” on page 9-48
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About This Tutorial

In this section...

“Objectives” on page 9-2
“About the Model” on page 9-2

“Design Requirements” on page 9-4

Obijectives

In this tutorial, you learn to use optimization methods to design a PID
controller to meet frequency-domain design requirements on a system’s
response.

You accomplish the following tasks using the GUI:

® Specify frequency-domain Bode magnitude and phase margin requirements.
® Design an initial controller to meet the frequency-domain requirements.

® Refine the initial controller design to limit the controller’s output signal.

About the Model

In this tutorial, you use the Simulink model named sldo_model2, as shown in
the next figure.



About This Tutorial

E!sldo_mo-delz - o] |
File Edit View Simulaion Format Tools Help
DFEHE|&B2R[E= 4|2 2 mpo | [Noms
3
“ FID 5 ! in oun |2
Unit Step
Controller Flant
Ready [100% [ [ |odeds v

The model contains a Controller block, which is a PID Controller. This block
controls the output of the Plant subsystem.

Using the Simulink Control Design software has linearized the Simulink
model at the operating point specified in the model. The sldo_model2.mat file
contains a preconfigured SISO Design Tool session saved after linearizing the
model. To learn more about linearizing Simulink models for control design,
see “Designing Compensators” in the Simulink Conitrol Design User’s Guide.

Double-click the Plant subsystem to open it. The plant is modeled as a
second-order system with delay. It contains Transfer Function and Transport
Delay blocks, as shown in the next figure.

=] sido_meodel1/Plant 10| =|
File Edit Wiew Simulation Format Tools Help
DSE@& sBR|(E= 4|52 = [

wor2
| .
e >

In1 s2+2 Wl zetas+wl "2

Y

w1 )

Transfer Fon

Out

Transport Delay

Ready [100% [ |ode4s
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To learn more about the blocks, see Transfer Fen and Transport Delay block
reference pages.

Design Requirements

The compensator you design in this tutorial must meet the following design
requirements:

* Bode lower magnitude bound of 0 in the frequency range 1le-3 to 1 rad/sec
¢ Phase margin greater than 60 degrees

e Controller output bounds in the range [-250 550]
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Configuring a Project for Optimization-Based Control
Design

To design a linear controller for a Simulink model, you must first configure
a Control and Estimation Tools Manager project.

1 Open a SISO Design Tool session for the linearized Simulink model by
typing the following command at the MATLAB prompt:

sisotool('sldo_model2.mat')

Note sldo_model2.mat file contains a preconfigured SISO Design Tool
session. This session was saved after Simulink Control Design software
linearized the sldo_model2 Simulink model.

This command opens the following windows:

e Simulink model

=] sldo_model2 i ] 5]
File Edit View Simulation Format Tools Help
DBES| =R 2oz r = [om &l @
3
“ FID 5 ! int outn |2
Unit Step
Controller Flant

Ready [100% [ [ |odeds v

To learn more about the model, see “About the Model” on page 9-2.
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9-6

e Control and Estimation Tools Manager GUI, which contains a SISO
Design Task node under the Simulink Compensator Design Task

node.
E! ‘Control and Estimation Tools Manager i =] £
File Help
= 5
&0 s d
4:\ Waorkspace ~Project Setting:
B Mmoot s . : .
perating Points Title: IPro]ect - sldo_madel2
=3 ‘IITILI|Ink ComPensator De G I
J SIS0 Design Task
Created by: I
Date modified: 10-Nov-2008
Simulink madel:  sldo_maodel2
Description: ;I
=l
l | W
4
=
Project node. 4
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e LTI Viewer for SISO Design Task window, which contains the following
plots:

= Closed-loop step response of the system in the top plot
= Output of the Controller block in the bottom plot

) LTI Viewer for SISO Design Task i =] 4|

File Edit Window Help

D &= |

Step Response
From: Unit Step To: Qut(1)

Amplitude

1 1 1 1
60 &0 100 120 140
Time (z&C)
Step Responze
From: Unit Step To: Out(1)

15 T T T T

Am plitude
e
T

Time (z&c)

LTI iewer [V Real-Time Update
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¢ A blank SISO Design for SISO Design Task window

S150 Design for SISO Design Task

SE




Configuring a Project for Optimization-Based Control Design

2 In the Control and Estimation Tools Manager GUI, select the Automated
Tuning tab in the SISO Design Task node.

E! ‘Control and Estimation Tools Manager
File Edt Tools Help

5 =] 3
B0 cd|9 o
‘_@ Workspace Architacturel Compensator Editorl Graphical Tuning I Analysis Plots  Automated Tuning I
=- 1l Project - sldo_model2
% Operating Points Design method: IOptimizat\on Based Tuning j
=5 Simulrk Compensator D ~Optimization Based Tuning
w

‘fou can use optimization-based tuning ta create an initial compensataor design or to refine the current compensatar
design:

Graphically specify design requirements For your system by positioning bounds on design or analysis plats such as
Bode, Michals, or Step Respanse. Then, use optimization-based methads to automatically tune compensator elements

to satisfy the design requirements, Compensator elements that are tunable via optimization-based tuning include
gains, poles, and zeros.

Requires the Simulink Design Optimization product.

Optimize Compensatars, |
. I I _'I Store Design Update Simulink Block Parameters I~ automatically update block parameters Help |
SISO Design Task Mode.

s 1 L
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3 Click Optimize Compensators.

This action creates a new Response Optimization node.

E! Control and Estimation Tools Manager

File Edit Tools Help

S0 Sd|9 &

4_:\ Warkspace Qverview I Compensatorsl Design requirementsl Optimization
B G Project - sldo_model2 —Overview
L Operating Paints
=] 31 Simulink Compensator Design
-] 5150 Design Task | |
+-[77) Design Histary 1 1
Design Operating Poir Step 1 : Step 2 : Step 3
jResponse Optimizatiol 1 1
| Set optimization I
: options :
| I
Select | I
compensators to l 1
optimize | I
| I
| I
| I
t Oplimize - = View results
| I
| I
| I
Select design 1 1
requirements : :
| I
| I
| I
Start Optimization | Hel |
4| LB p p
4
(=
4

Response Cptimization
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Designing an Initial PID Controller to Meet Bode Magnitude
and Phase Margins Requirements

In this section...

“Specifying the Controller Parameters” on page 9-11

“Specifying Bode Magnitude and Phase Margin Design Requirements” on
page 9-15

“Designing the Controller” on page 9-25

Specifying the Controller Parameters
In this portion of the tutorial, you specify the controller parameters to design.

You must have already configured a project for control design, as described in
“Configuring a Project for Optimization-Based Control Design” on page 9-5.

To specify the controller parameters to design:

9-11
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9-12

E! Control and Estimation Tools Manager

1 In the Control and Estimation Tools Manager GUI, select the
Compensators tab in the Response Optimization node.

~=1olx|
File Edit Tools Help
S8 d|9 =
4_)« Workspace Overview Compensators I Design requirements | Optimizationl
EIG Project - sldo_modelZ | select compensator elements to optimiz
#-L ) Operating Paints
E% Simulink Campens [~ Optimize Compensataor elements | Value I Initial guess | Minimum Maximum Typical value
= ﬂ O sldo_model2/Controller
; O Gain -Inf Inf
O Real Zero -Inf Inf
O Real Zero -Inf Inf
O Real Pale -Inf

Inf

Right click on a compensator name to change its reprasentation.

Use Value as Initial Guess |

KIS 0

Start Optimization |

Help |

Respanse Optimization

s L L

The controller parameters appear as poles and zeros in the Compensator
elements column and represent the following:

¢ Gain — Overall gain of the controller

¢ Real zeros — Zeros resulting from the differentiator and integrator

e Real pole — Pole resulting from the low-pass filter of the differentiator

Tip To view the structure of the Controller block, right-click the block
and select Look Under Mask.
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2 For convenience, change the PID controller parameters to Simulink block
mask parameters format. To do so, right-click the sldo_model2/Controller
column, and select Parameterized format.

E! ‘Control and Estimation Tools Manager o =] 5

File Edit Tools Help
B0cd|9

ﬂ:\ Workspace Qverview Compensators I Design requirementsl Optimization |

=i G Project - sida_madel2 ~Select compensatar elements ko optimize
L Operating Paints

=t ;:| simulink Compensatar Design [ Opti... Compensatar elements I Valus IInitiaI gu...I Minimum | Maximum | Typical ...
[=] ﬂ 5150 Design Task | sldo_model2/Controller |
+ Design Histary O Gain v Pole/Zero format -Inf Inf 0.1
i Design Operating Poir O Real Zero -Inf Inf
E ﬂ Respanse Opkimizatio ] Real Zero Inf Inf
] Real Pole | | [ [ mnf nF

Right click on a compensator name ta change its reprasentation,

Use Value as Initial Guess |

q | LI Skart Optimization | Help |

x [

Response Optimization
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This action displays the controller parameters as Simulink block mask

parameters P, I, and D, as shown in the next figure. To learn more about
mask parameters, see “Mask Parameters” in the Simulink documentation.

=] Control and Estimation Tools Manager

=10l x|
File Edit Tools Help
i = A A
@\ Workspace Qvervien Compensators I Design requirements | Optimization |
B E Project - sldo_model2 ~Select compensator elements to optimiz:
[#-Lgd) Operating Points
S-E] simulink Compensator Dasign Task [~ Optimize Compensator elements | Value | Initial guess I Minimum Maximum | Typical value
=1-#) SIS0 Design Task O sldo_model2/Controller
=[] Design History O P 1 1 -Inf Inf 1
Design Operating Point O I 0.1 0.1 -Inf Inf 1
ﬂ Response Optimization ] D 0.1 0.1 -Inf Inf i
] N 100 100 -Inf Inf 1
Right click on a compensator name ta change its reprasentation,
Use Value a5 Initial Guess |
‘l I_’I Skart Optimization | Help |

Response Optimization

s L L]

The Compensators tab displays the following parameter settings:

® Value — Current controller parameter value

¢ Initial Guess — Initial controller parameter value

® Minimum and Maximum — Controller parameter bounds

¢ Typical Value — Scaling factor for the controller parameter

To learn more about the parameter settings, see “Changing Tuned

Parameter Specifications” in the Simulink Design Optimization User’s

Guide.
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3 In the Optimize column, select the check boxes for P, I, and D.

=] Control and Estimation Tools Manager 1ol x|

File Edit Tools Help

i i = B A

@\ Workspace Qvervien Compensators I Design requirements | Optimization |
B E Praject - sldo_model2 Select compensator elements to optimiz:
-1 Operating Points
E}% Simulink Compensator Dasign Task [~ Optimize Compensator elements | Value | Initial guess I Minimum | Maximum |Typ\ca| wvalue
=1-#) SIS0 Design Task | sldo_madel2/Controller
{5 Design Histary W P [ 1 I 1 [ mf ] Inf ‘ 1
Design Operating Point = I 0.1 0.1 -Inf Inf 1

ﬂ Response Optimization

O N 100 100 -Inf Inf 1

Right click an a compensator name to change its reprasentation,

Use Value as Initial Guess |

‘l I_’I Start Optimization | Help |

s L]

Response Optimization

Specifying Bode Magnitude and Phase Margin
Design Requirements

In this portion of the tutorial, you specify the Bode magnitude and phase
margin requirements that the controller must satisfy.

Before you specify the design requirements, you can specify the controller
parameters to design, as described in “Specifying the Controller Parameters”

on page 9-11.

To specify the Bode design requirements:
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1 In the Response Optimization node of the Control and Estimation Tools
Manager GUI, select the Design requirements tab.

=] Control and Estimation Tools Manager 1ol x|
File Edit Tools Help
SDad|9 @
{\ Workspace Overvlewl Compensators Design requirements I Optimization
B E Praject - sldo_model2 ~Select design requirements to satisfy
-1 Operating Points - - -
=] simulink Compensatar Design Task I™ | Optimize | Response plat I Design requirement
-] 5150 Design Task
- Design History
Design Operating Paink
ﬂ Response Optimization
Click the 'Add new design raquirernent’ button or right click on a plot to 2dd a new design requiremant.
Show Plots | | Add new design requirement... .

Skart Optimization | Help |

Response Optimization

s L]
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2 Click Add new design requirement.

This action opens the New Design Requirement dialog box.

) Mew Design Requirement o ] A |

Design requirement type:

Requirement for response: ICInsed Loop from Unit Step to Plant LI

~Design requirement parameters

Initial value: I o Final value:
Step time: I i}

Rise time: I 5 % Rise: 3
Settling time: I 10 % Settling: 1.0000
% Overshoot: I 10,0000 % Undershoat:

OK | Cancel | Help |

il
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3 Specify the Bode magnitude lower limit requirement:
a In the New Design Requirement dialog box, select Bode magnitude
lower limit from the Design requirement type drop-down list.
This action updates the New Design Requirement dialog box, as shown

in the next figure.

J} New Design Requirement =0l =l

Design requirement type:

Requirement for response: I .. Loop from Unit Step ta Controller LI
~Design reguirement parameters
Segments:
Skart End
Frequency | Magnitude | Frequency | Magnitude Slope Weight
1 0 10 0 0 1
Insert | Delete |
OK | Cancel | Help |

b Select Open Loop at outport 1 of Controller from the
Requirement for response drop-down list.

¢ In the Frequency field of the Start column, enter 1e-3.
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d In the Frequency field of the End column, enter 1.

The New Design Requirement dialog box resembles the following figure.

) New Design Reguirement =0 x|

Design requirement type: IEDde magritude lower limit LI

Requirement for respanse: I ..&n Loop at oukpart 1 of Cantraller LI

~Design requirement parameters

Segments:
Start End
Frequency | Magnitude | Frequency | Magnitude Slope Weight
1.0000e-03 [ ] 0 4] 1

Insert | Delete |

OK | Cancel | Help |

e Click OK to close the New Design Requirement dialog box.
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ﬂ Workspace

The Bode lower magnitude limit is added to the Design requirements
tab, as shown in the next figure.

E! ‘Control and Estimation Tools Manager
File Edt Tools Help

B0 cd|9 o

=- 1l Project - sldo_model2

Overview I Compensators Design requirements I Optimization

[ Operating Paints
=2 Simulink Compensatar De

=] 5150 Design Task
Design History

Design Operating
‘_1 Response Opkirni

~Select design requirements to satisfy

[~ Optimize Respanse plak | Design requirement
| Open Loop at outport 1 of Controller
= Open-Loop Bode Editor for Open Loop 1 (L1) | Lower gain limit from 0.001 to 1 rad/sec

Show Plots | | Add new design requirement...

Click the 'Add new design requiremznt’ button or right dick on a plat ta add a new design requirement,

Skart Optimization |

Help |

Unda

s L L
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The SISO Design for SISO Design task window also updates to show the
Bode plot with the design requirement displayed as the black line segment.

) SISO Design for SISO Design Task

File Edit View Designs Analysis Tools Window Help

=0l x|

|

[ x 0 ¥ & 6 & W

Open-Loop Bode Editar for Open Loogp 1 (L1)

a0 T T T T

u\

Magnitude [dB)
n
o

-100
GM.Inf

Freq: Inf
Stable loop

-150

-45 T T T T

Phase (deq)

-135

P804 degy
Fred: 0505 radizec

180 e e el

TR S S e S R T = T R

BT Y S A S SR )

10 107 107 10" 10'
Freguency (radfzec)

10°

107

Right-click on the plots for more design options.
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4 Add the phase margin requirement:

a In the SISO Design window, right-click the white area on the top plot,
and select Design requirement > New.

) SISD Design for SIS0 Design Task _ 1Ol =l

File Edit View Designs Analysis Tools Window Help ]
x o e
X 0o = = %|+\\{ﬂ?|¥?

Open-Loop Bode Editor for Open Loop 1 (L1)

a0 T T T T T T
D \Q |
o
% Add PalefZero 3
E -50 Delete PolefZera -
§1 Edit Compensator. ..
= Gain Target 4
-100 B
G M. Inf Show ’
Fred: Inf Design Requiremants
Stable loop . .
150 L, (G Edi...
_d5 - - - - Full View
Properties. ..
= =90 -
{7
L1
53
L]
W
£
o -135 _
P 804 deg
Freo 0,505 radisec
)| Y Y By S U PP YO S gy — = -
10° 10* 107 10f 10’ 10° 10° 10

Freqguency (radisec)

Fight-click on the plots for more design options.
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This action opens the New Design Requirement dialog box, as shown in
the next figure.

) New Design Requirement ;IE'EI

Design requirement type:ILlpper gain limit LI
~Design requirement parameters
Segments:
Skart End
Frequency | Magnitude | Frequency | Magnitude Slope Weight
1 0 10 0

Insert | Delete |

Cancel | Help |

b In the New Design Requirement dialog box, select Gain & phase
margins from the Design requirement type drop-down list.

The New Design Requirement dialog box updates to display the Gain
Margin > and Phase Margin > options, as shown in the next figure.

.} Hew Design Requirement =01 x|

Design reqguirement type: | == g 1

—Design reguiremesnt parameters
[ zain margin = I 20
[~ Phase margin = I 30
oK | Cancel | Help |

¢ Select the Phase margin > check box, and enter 60 in the adjacent field.
Then, click OK to close the dialog box.
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) New Design Requirement 0] x|

Design reguirement type:l...in & Phase margins ;I

Design requiremenk parameters

[~ zain margin =

¥ Phase margin =

IEIII

oK | Cancel | Helg |

The Design requirements tab in the Control and Estimation Tools

Manager GUI updates. It now displays the phase margin requirement,
as shown in the next figure.

E! Control and Estimation Tools Manager

File Edit Tools Help

(i =T N

ﬂ:\ Waorkspace
=- | Project - sldo_model2
ia Operating Paints
=1 E] Simulink Compensator Dz
- #£) 5150 Design Task
iﬁ Design Hiskary
i Design Operating
B ﬂ Response Opkirmi

Qverview I Compensators Design requirements I Optimization
~Select design requirements to satisfy

™ Optimize Respanse plot | Design requirement:
| Open Loop at outport 1 of Controller
= Open-Loop Bode Editor for Open Loop 1 (L1) | Lower gain limit from 0,001 ta 1 radfsec
= Open-Loop Bode Editor for Open Loop 1 (L1)

| Requiremank: PM = 60

Click the 'Add new design requirement’ button or right dick on a plot to add a new design requirement,

Show Plats

| Add new design reguirement. ..

Start Optimization | Help |

9
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The SISO Design window also updates to display the phase margin

requirement.

) SISD Design for SIS0 Design Task i =] 4
File Edit View Designs Analysis Tools Window Help ]
X o I+ =
X o ¥ -S| %A
Open-Loop Bode Editor for Open Loop 1 (L1)
50 T T T T T T
D \Q )
o
=
=< a0 Requirement:
2 7 PM = BO
=
L=1]
[
=
-100
G Inf
Freg; Inf
Stable loop
180 Ll
-45 T T T T T T
= =90 J
f=1)
L
=)
L
Lo
£
o -135 J
P 804 deg
Freo 0,505 radisec
= | ey g N
3 2 -1 ] 1 2 E] :
10 10 10 10 10 10 10 10

Freqguency (radisec)

Fight-click on the plots for more design options.

Designing the Controller

In this portion of the tutorial, you design the controller to meet the Bode

magnitude and phase requirements.

You must have already specified the controller parameters to design, as
described in “Specifying the Controller Parameters” on page 9-11, and the
design requirements, as described in “Specifying Bode Magnitude and Phase

Margin Design Requirements” on page 9-15.
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To design the controller:

1 In the Optimization tab, click Start Optimization.

=] Control and Estimation Tools Manager
File Edit Tools Help

i = ™ A

=10l x|
{\WDT’GPGEE Dvervlewl Ccmpensatorsl Design requirements  Optimization |
- Project - sldo_model2 ~Optimization progress
(L) Operating Points
=B8] simulink Compensatar Design Task Ikeration | Eval-Count | Cost: Function I Constraink ... I Step size Procedure | Optimization options. .. I
=) SIS0 Design Task -
_ Design Histary Display options. .. |
Design Operating Paoink
fResponse Optimization
[
=l
[
‘l I_’I Skart Optimization 'J Help |
1
4
=
Response Optimization v

The Optimization tab updates as shown in the next figure.
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E! ‘Control and Estimation Tools Manager

File Edt Tools Help

SD|cd|9 @

{\ Workspace

=-Bgh| Praject - sldo_model2

[ Operating Paints

B Simulink Compensatar De
- #] 5150 Design Task

: -- Design Hiskary

: Design Operating

ﬂ Response Opkirmi

O

| Compensatars | Design requirements ~ Optimization I

Optimization progress

Iteration I Eval-Count |Cost Funct...IConstrain‘.‘I Step size I Procedurs I

Optimization options.. . |

[] | 7 | o | smaz | |

=

B
Constructing optimization problem.. d
Optimization started 12-Mow-2003 11:44:04

=]

Display options. ..

Response Optimization

s L

® At every optimization iteration, the default optimization algorithm
Gradient descent reduces the distance between the current response
and the magnitude requirement line segment by modifying the controller
parameters. Simultaneously, the software also computes the phase
margin and reduces the distance between the current response and the
phase margin. To learn more about the optimization algorithm, see
“Selecting Optimization Methods” in the Simulink Design Optimization

User’s Guide.

e After the optimization completes, the Optimization tab displays the
optimization iterations and status, as shown in the next figure.
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E! Control and Estimation Tools Manager

File Edit Tools Help

g0 cd|9

@ Workspace
=B8] Praject - sldo_model2
- Operating Paints
B Simulink Compensator
-] 5150 Design Task
Design Hiskory
Design Opera
D Response Opl

KT — |

Overview | Compensators | Design requirements Optimizationl

- Optimization progress

talerances.

Optimization started 10-MNovw-2008 14:01:11
Optimization finished 10-Mow-2002 14:01:21
Successful termination. Found a feasible or optimal solution within the specified

Ikeration Eval-Count | Cost Function|Constraint... | Step size Procedure Optimization options... |
0 7 0 57.12 a
1 14 0 1.777 5.36 Display options. .. |
2 21 '] 1.697 12.1 Hessian m...
3 28 0 0 21.7
=
Constructing optimization problem... ;I

{EESrE Optimization

Redo

s 1

The message Successful termination indicates that the optimization
algorithm found a solution that meets the design requirements. For
more information about the outputs displayed in the Optimization
progress table, see “Displaying Iterative Output” in the Optimization
Toolbox documentation.
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2 Examine the controller parameters and the system’s response:

a View the optimized parameter values in the Value field of the
Compensator tab.

E! ‘Control and Estimation Tools Manager

=13l
File Edt Tools Help
(i =T A
g Workspace Overview Compensators I Design requirementsl Optimization |
EG Project - slda_model2 ~Select compensator elzments to optimize
[ Operating Paints
E}% Simulink Compensatar De [~ Optimize Compensatar elements I Value IIn\tiaI guess| Minimum | Maximum | Typical v...
E‘"ﬂ 5150 Design Task | sldo_modelZ /Controller
_m Design Hiskary v P 6.7627 1 -InfF Inf 1
Design Operating v I 3.4445 0.1 -Inf Inf 1
a Respanse Opkimi v D 11.106 0.1 -Inf Inf 1
C N 100 100 -Inf Inf 1

Right click on a compensator name ta change its representation.

Use Value as Initial Guess |

Skart Optimizatian Help

N EAD

b Examine the system’s response on the following plots:
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® The SISO Design window

) SISD Design for SIS0 Design Task i =] 4
File Edit View Designs Analysis Tools Window Help ]
X o I+ =
X o ¥ -S| %A
Open-Loop Bode Editor for Open Loop 1 (L1)
40 T T T T T T
20+ =
0 -
o
=20 -
§ Recuirement;
E 40 Pl = BD_
[
=
=) J
G Inf
80| Freo Inf B
Stable loop
100 Ll
-80
=
L
=)
o 135 F 4
Lo
[
=y
=%
P 861 deg
Freo 2.79 radizec
P 1 | Py U P V1 BRSPS Y] SRy PPy [P PR (PSP P FTY PRSP RTY SRl
10° 107 10" 10° 10’ 10° 10° 10
Freqguency (radisec)
Undoing Optithize compensatars.

= The top plot shows that the magnitude of the system, displayed as
the blue curve, lies outside the yellow region. This plot indicates
that the system has met the Bode magnitude requirement.

= The bottom plot displays the phase margin (P.M.) value of 86.1
degrees. This indicates that the system has met the phase margin
design requirement of >60 degrees.
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e The LTI Viewer

=loix|

Fil= Edit ‘Window Help

D&% X|E

Step Responze
From: Unit Step To: Qut(1)

Am plitude

Time (3&C)
Step Response
From: Unit Step To: Qut(1)
1500 T T T T T T T T T

Amplitude

500 I I I 1 1 I I I 1
0.05 01 0.15 0.2 0.25 0.3 0.35 0.4 0.45 0.5

Time (2ec)

LTI Wiewer ¥ Real-Time Update

= The top plot shows that the closed-loop response of the system is
stable. The system with the designed controller thus meets both
the magnitude and phase margin requirements.

= The bottom plot in the LTI Viewer shows that the peak value of
the controller’s output is 1000, which is very large and can cause
damage to the plant. To limit the controller output, you apply
lower and upper bounds on the signal, as described in “Refining the
Controller Design to Meet Controller Output Bounds” on page 9-32.
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Refining the Controller Design to Meet Controller Output

Bounds

In this portion of the tutorial, you refine the controller to satisfy bounds on
the controller’s output.

You must have already designed an initial controller, as described in
“Designing an Initial PID Controller to Meet Bode Magnitude and Phase
Margins Requirements” on page 9-11.
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To tune the compensator parameters to meet the bounds on the controller’s

signal:

1 Add the upper-bound on the controller’s output:

a In the LTI Viewer, right-click the white area on the bottom plot, and
select Design requirement > New.

) LTI Viewer for SISO Design Task _ 1Ol =l
File Edit Window Help
D&~ ~|E
Step Response
From: Unit Step To: Qut(1)
1.5 T T T T T T T T T
~ R —— S
=
=
[=%
E os -
U 1 1 1 1 1 1 1 1 1
0 0.5 1 115 2 25 3 35 4 45 5
Time (3eC)
Step Responze
From: Unit Step To: Qut(1)
1500 T T T T T T T T T
1000 Plot Types 4 7
§ Systems L3
£ 500 _ N
E Characteristics 4
0 Grid
Mormalize
500 | | | 1
0 0.05 01 v Full View 03 0.35 04 0.45 0.5
Properties...
" Design Requiremants b
LTI Wigwer —%I ¥ Real-Time Update
it

This action opens the New Design Requirement dialog box.
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) Hew Design Requirement ] e

Design regquirement type:IStep response bounds LI

—Design requirement parameters
Initial value: I o Final value: I 1
Step time: I 1]
Rise time: I 5 % Rise: I B0
Settling time: I 10 % Settling: I 1.0000
% Overshoot: I 100000 % Undershoot: I 1

Cancel | Help |

b Inthe New Design Requirement dialog box, select Upper time response
bound from the Design requirement type drop-down list.

) New Design Requirement

Design reguirement type:

=101 x|

Upper time response bound

~Design reguirement parameters
Segments:
Skart End
Time Amplitude Time Amplitude Slope Weight
0 1 10 1 0 1
Insert | Delete |

oK | Cancel | Help |

¢ In the Time field of the End column, enter Inf.
d In the Amplitude field of the Start column, enter 550.
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e In the Amplitude field of the End column, enter 550.

The New Design Requirements dialog box resembles the following figure.

) New Design Requirement

=100 =]
Design reguirement type:IUpper time response bound LI

~Design requirement parameters
Segments:

Start End

Time Amplitude Time Amplitude Slope Weight
1] 550 Inf 5500 1] 1
Insert | Delete |

OK | Cancel | Help |

Click OK to close the dialog box.
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The Design requirements tab in the Control and Estimation Tools
Manager GUI updates. It now displays the upper-bound requirement, as
shown in the next figure.

E! Control and Estimation Tools Manager = 3]
File Edit Tools Help

S0 d|9 o

@ Workspace Overview | Compensators Design requirements | Optimization |
=l Project - sldo_madelz

1 g Operating Paints

~Select design requirements to satisfy

=] simulink Compens I” Optimize Respaonse plat I Design requirement
= ﬂ SIS0 Design '’ O Closed Loop from Unit Step to Controller
-- Design Hi = Step Response | Upper time response bound from 0 ko 10 sec
- =t Design O C Open Loop at outport 1 of Controller
ﬂ Response ¥ Open-Loop Bode Editor for Open Logp 1 (L1) | Lawer gain limit from 0,001 to 1 radfsec
V Open-Loop Bode Editor for Open Logp 1 (L1) | Requirement: PM > 60

Click the 'Add new design requirsment’ buttan or right click on a plat to add a new design requirement,

Show Plots | Add new design requirement... |

Help |

s L L
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The LTI Viewer also updates to show the design requirement, as shown

in the next figure.

) LTI Viewer for SISO Design Task i =] 4]
File Edit Window Help
= | B & | 3
Step Response
From: Unit Step Too Ot
1.5 | | | ' ' | | | ' =
o A e
=
2
[~}
§ 05 o
0 | | | L L | | | L |
0 0.5 1 15 2 25 3 3.5 4 45 S
Time (zec)
Step Response
Fraorm: Unit Step Too Ot
1500
1000
i}
=
£ 500 \— =
[=3
& N
500 | | | L L | | | L |
u] 0.0s 0.1 015 0.2 0.25 0.3 0.35 0.4 0.45 0.5
Time (zec)
LTI Wigwer ¥ Real-Time Update

2 Add the lower-bound on the controller’s output:

a Right-click the white area in the bottom plot in the LTI Viewer, and

select Design requirement > New.

This action opens the New Design Requirement dialog box.
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9-38

Select Lower time response bound from the Design requirement
type drop-down list.

The New Design Requirement dialog box updates to show the lower
bound, as shown in the next figure.

) New Design Requirement -0l x|

ower time response bound

Design reguirement type:

~Design requirement parameters
Segments:
Skart End
Time Amplitude Time Amplitude Slope Weight
] 1 10 1 0 1
Inserk | Delete |
OK | Cancel | Help |

¢ In the Time field of the End column, enter Inf.
d In the Amplitude field of the Start column, enter -250.
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e In the Amplitude field of the End column, enter -250.

The New Design Requirement dialog box resembles the next figure.
Click OK to close the dialog box.

) New Design Requirement -0 x|
Design reguirement t'y'pe:ILcnwer time response bound ;I
~Design requirement parameters
Segments:
Skart End
Time Amplitude Time Amplitude Slope Weight
] -250 Inf |-250 0 1

Insert | Delete |

OK | Cancel | Help |
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The Design requirements tab in the Control and Estimation Tools

Manager GUI updates. It now displays the lower-limit requirement, as
shown in the next figure.

E! ‘Control and Estimation Tools Manager =ol x|

File Edit Tools Help

SD|E8d|9 =

=l Project - sldo_maodelz
{5 Operating Points

~Select design requirements to satisfy

Q« Workspace Overviewl Compensakors Design requirements I Optimizationl

5] simulink Compens ||| Optimize

Response plat

I Design requirement

&%) 5150 Design

Closed Loop from Unit Step to Controller

'- Design Hi

Step Responss
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Refining the Controller Design to Meet Controller Output Bounds

The LTI Viewer also updates to show the lower-bound on the controller’s
output, as shown in the next figure.

) LTI Viewer for SISO Design Task i ]
File Edit Window Help
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Step Response
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1 5 1 1 1 1 1 1 1 1 1 'l
o 1 ..............................
=
=
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i}
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£ 500 F =
N
D ................................
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9 Tutorial — Designing a PID Controller Using Optimization-Based Tuning

3 Optimize the parameters to meet the design requirements on the controller
output:

a In the Compensators tab, select the rows containing P, I, and D, and
click Use Value as Initial Guess.

E! Control and Estimation Tools Manager

8 [=[ -3

File Edit Tools Help
S0 cd|9 ™
4:\ Warkspace Overview Compensators I Design requirementsl Optimization |
E G Project - sldo_model2 -Select compensator elements to optimize

- Operating Paints

=] simulink Compensatar De I [~ Optimize I Compensator elements I Value IIn\tiaI guess| Minimum | Maximum | Typical v...

[=] ﬂ SISO Design Task | sldo_model2,/Controller

({3 Design Histary
i Design Operating
¢ #) Response Optimi

100 -Inf Inf

Right click on 2 compensator name ta change its representation,

Use Value as Intial Guess N

‘I I LI Start Optimization | Help |

9
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Refining the Controller Design to Meet Controller Output Bounds

When you run the optimization again, the optimization algorithm uses
the updated parameter values as the starting point for refining the
values.

Clicking Use Value as Initial Guess updates the values in the Initial
Guess column, as shown in the next figure.

E! ‘Control and Estimation Tools Manager o =] 5

File Edt Tools Help
S0 Sd|9 &

‘4_:\ Warkspace Overvien Compensators I Design requirements | Optimization |
= W Project - sldo_model2 ~Select compensator elements ko optimize

L Operating Paints

= ;:| Simulink Compensatar De I~ Optimize Compensator elements I Value IIn\tiaI guess| Minimum | Maximum | Typical v...
= B SIS0 Design Task 1 sldo_model2 /Controller
iﬁ Design Histary e P 6.7627 6.7627 -Inf Inf 1
i Design Operating = I 34445 34445 -Inf Inf 1
*#'] Respanse Optimi I D 11.106 11.106 -Inf Inf 1
r N 100 100 -Inf Inf 1

Right click on a compensator name ta change its representation,

Use Value a5 Inftial Guess |

Help

[

Response Optimization
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b In the Optimization tab, click Start Optimization.

® At every optimization iteration, the optimization algorithm reduces

the distance between the current response and the upper and lower
bounds on the signal.

® After the optimization completes, the Optimization tab resembles
the next figure.

E! ‘Control and Estimation Tools Manager

=13lx]

File Edt Tools Help
SOEd|=2 ™
‘_@ Workspace Overview I Compensators I Design requirements  Optimization I
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Optimization finished 10-Now2003 13:20:27
Successful termination. Found a feasible or optimal solution within the specified
talerances.
=l
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Refining the Controller Design to Meet Controller Output Bounds

4 Examine the parameter values refined controller and the system’s response:
a Examine the following response plots:

e The LTI viewer

) LTI Viewer for SISO Design Task i [m] ]
Fil= Edit Window Help
SEIERYE
Step Response
Frotm: Unit Step To: Outi1)
13 0 0 0 0 0 0 0 0 =
e T T
=
£
[~}
g oost -
0 L L L L L L L L L I
a 1 2 5 4 ] (&) T g el 10
Time (s2c)
Step Response
From: Unit Step To: Cuti1)
1000
o 200 =
=
2
=3
E (1] R
-500
o 0.0s 01 015 02 025
Titne (sec)
Bl [¥ Real-Time Update

The bottom plot shows that the controller output lies between 550
and -250, and thus meets the design requirement on the controller’s
output.

Note You must also check that the closed-loop response, shown in
the top plot, remains stable after refining the controller design.

9-45



9 Tutorial — Designing a PID Controller Using Optimization-Based Tuning

9-46

® The SISO Design window

) SISO Design for SISO Design Task
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The plots show that after refining the design, the system continues
to meet the magnitude and phase margin requirements specified in

“Design Requirements” on page 9-4.




Refining the Controller Design to Meet Controller Output Bounds

b View the optimized controller parameter values in the Value field in the
Compensators tab.

E! ‘Control and Estimation Tools Manager

=13l
File Edt Tools Help
(o =T
Q Workspace Overview Compensators I Design requirementsl Optimization |
=W Project - sldo_mad=l2 ~Select compensator elzments to optimize
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Right click on a compensator name ta change its representation.

Use Value as Initial Guess |

Skart Optimizatian Help
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5 Select the SISO Design Task node, and click Update Simulink Block
Parameters.

This action writes the optimized controller parameter values to the
Controller block in the Simulink model.
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Saving the Project
To save a project with the optimized controller parameters:

1 In Control and Estimation Tools Manager GUI, select File > Save.

This action opens the Save Projects dialog box.

) Save Projects =10 =]

Projects:

=

0K | Cancell Helgp |

2 In the Save Projects dialog box, select Project - sldo_model2, and click
OK to open the Save Projects window .

3 In the Save Projects window, enter sldo_model2_optimized.mat in the
File name field, and click Save.

The action saves the project as a MAT-file.

Tip You can reload this project by typing
sisotool('sldo_model2 optimized') at the MATLAB prompt.
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e “Adapting the Lookup Table Values Using Time-Varying I/O Data” on
page 10-16
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About This Tutorial

In this section...

“Objectives” on page 10-2
“About the Data” on page 10-2

“Overview of Modeling a System Using Adaptive Lookup Table” on page
10-3

Obijectives
In this tutorial, you learn how to capture the time-varying behavior of an

engine using an n-D adaptive lookup table. You accomplish the following
tasks using the Simulink software:

® (Configure an adaptive lookup table block to model your system.

® Simulate the model to update the lookup table values dynamically.

e Export the adapted lookup table values to the MATLAB workspace.

® Disable the adaptation process and use the adaptive lookup table as a
static lookup table.

About the Data

In this tutorial, you use the data in vedata.mat which contains the following
variables measured from the engine:
® X — 10 input breakpoints for intake manifold pressure in the range [10,100]
® Y — 36 input breakpoints for engine speed in the range [0,7000]
e 7 — 10x36 matrix of table data for engine volumetric efficiency

To learn more about breakpoints and table data, see “Anatomy of a Lookup

Table” in the Simulink documentation.

The output volumetric efficiency of the engine is time varying, and a function
of two inputs—intake manifold pressure and engine speed. The data in the
MAT-file 1s used to generate the time-varying input and output (I/0) data for
the engine.

10-2



About This Tutorial

Overview of Modeling a System Using Adaptive
Lookup Table

The process for modeling a system using adaptive lookup table consists of the
following tasks:

¢ “Building a Model Using Adaptive Lookup Table Blocks” on page 10-4.

e “Adapting the Lookup Table Values Using Time-Varying I/O Data” on
page 10-16.

Simulink Design Optimization software provides blocks for modeling systems
as adaptive lookup tables. You build a model using the adaptive lookup table
blocks, and then simulate the model to adapt the lookup table values to the

time-varying I/O data. During simulation, the software uses the input data to
locate the table values, and then uses the output data to recalculate the table
values. The updated table values are stored in the adaptive lookup table block.
To learn more about adaptive lookup tables, see “Adaptive Lookup Tables”.
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Building a Model Using Adaptive Lookup Table Blocks

In this portion of the tutorial, you learn how to build a model of an engine
using an Adaptive Lookup Table block.

1 Open a preconfigured Simulink model by typing the model name at the
MATLAB prompt:

enginetablei_data

This command also loads the variables X, Y and Z into the MATLAB
workspace. To learn more about this data, see “About the Data” on page
10-2.

The Experimental Data subsystem in the Simulink model generates the
time-varying I/0O data during simulation.

E! enginetablel_data ;lﬂlll

File Edit View Simulaton Format Tools Help

OSR&E| + 28| 4|22 > =0 | [Nm =]

Experiments| Data

u

Ready [100% [ |ode4s v
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Building a Model Using Adaptive Lookup Table Blocks

2 Open the Simulink Design Optimization library by typing the following
command at the MATLAB prompt:

sdolib
=] Library:sdolib =] B3]
File Edit View Format Help
~ .
DZEHE B[4 |2 hERE|
Simulink Design Optimization
Response
RMS Optimization
Blocks Demos
Signal Constraint
N . Use these blodks to Double clidk on this blodk
_"mad" this blad(ta. build signal energy to ses svailsble demos
the signals to be constrained g ) ay sdaotive Lockup Tables
in your SIMULINK model. constraints Acep a
Ready 100% Locked v

3 Double-click the Adaptive Lookup Tables block to open the Adaptive
Lookup Tables library.

E! Library:sdolib/Adaptive Lookup Tables -0 x|

File Edit View Format Help

DESE& e e |2 nED

1-0 T{u)

Adaptive Lookup
Table (10 Stair-Fit)

Ready

Adaptive Lookup Tables

2-DTiu)

n-D T{u)

y N y N
Adaptive Lookup Adaptive Lookup
Table (20 Stair-Fit) Table (nD Stair-Fit)
[100% |Locked Y
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Simulink Design Optimization software provides three Adaptive Lookup
Table blocks. In this tutorial, you use the Adaptive Lookup Table (nD
Stair-Fit) block to model your system. To learn more about the blocks,
see “Block Reference”.

4 Drag and drop the Adaptive Lookup Table (nD Stair-Fit) block from the
Simulink Design Optimization library to the Simulink model window.

SL=Ik
File Edit View Simulation Format Toolzs Help
DE&| fB2R|(E= 42+ 500 | [Nomal =

Experiments| Data

2.0 T(u)

u

Adaptive Lookup
Table (nD Stair-Fit)

Ready 100% |ode4s v

10-6



Building a Model Using Adaptive Lookup Table Blocks

5 Double-click the Adaptive Lookup Table (nD Stair-Fit) block to open the
Function Block Parameters: Adaptive Lookup Table (nD Stair-Fit) dialog
box.

E! Function Block Parameters: Adaptive Lookup Ta x|

— Adaptive Lookup Table {nD) (mask) {ink)

Perform adaptive table lockup. Breakpoints relate the coordinate inputs to
cell locations in the table. The data is used to dynamically update the cell
values at these locations.

—Parameters
Number of table dimensions:
|
Table breakpoints (cell array):
I{[10,22,3 1,40, [10,22,31,40]}

™ Make initial table an input
Table data (initial):

[[456;16 13 20;10 18 23]

Table numbering data:

[[123456;789]

Adaptation method: ISampIe mean (with forgetting) ;I
Adaptation gain {0 to 1):
[o.3

I~ Make adapted table an output
[™ Add adaptation enable/disable/reset port

[ Add cell lock enable/disable part —

1=
0K I Cancel | Help | Apply |

Action for out-ofrange input IIgnore ;I

6 In the Function Block Parameters dialog box:
a Specify the following block parameters:

¢ Table breakpoints (cell array) — Enter {[X; 110], [Y; 7200]}
to specify the range of input breakpoints.

¢ Table data (initial) — Enter rand(10,36) to specify random
numbers as the initial table values for the volumetric efficiency.

¢ Table numbering data — Enter reshape(1:360,10,36) to specify
a numbering scheme for the table cells.

b Verify that Sample mean (with forgetting) is selected in the
Adaptation method drop-down list.
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¢ Enter 0.98 in the Adaptation gain (0 to 1) field to specify the forgetting
factor for the Sample mean (with forgetting) adaptation algorithm.

An adaptation gain close to 1 indicates high robustness of the lookup
table values to input noise. To learn more about the adaptation gain, see
“Sample Mean with Forgetting” in “Selecting an Adaptation Method”.

d Select the Make adapted table an output check box.
This action adds a new port named Tout to the Adaptive Lookup Table

block. You use this port to plot the table values as they are being
adapted.

e Select the Add adaptation enable/disable/reset port check box.

This action adds a new port named Enable to the Adaptive Lookup Table
block. You use this port to enable or disable the adaptation process.

f Verify that Ignore is selected in the Action for out-of-range drop-down
list.

This selection specifies that the software ignores any time-varying inputs
outside the range of input breakpoints during adaptation.

Tip To learn more about the Adaptive Lookup Table (nD Stair-Fit) block
parameters, see the Adaptive Lookup Table (nD Stair-Fit) block reference

page.




Building a Model Using Adaptive Lookup Table Blocks

After you configure the parameters, the block parameters dialog box looks
like the following figure.

E! Function Block Parameters: Adaptive Lookup Table {(nD 1[

— Adaptive Lookup Table (nD) (mask) (ink)

Perform adaptive table lookup. Breakpaints relate the coordinate inputs to cell
locations in the table. The data is used to dynamically update the cell values at
these locations.

—Parameters
Mumber of table dimensions:
I
Table breakpoints (cell array):
| {0 110], [1; 72001}

[~ Make initial table an input
Table data (initial):

Jrand(10,36)

Table numbering data:

I reshape(1:360,10,38)

Adaptation method: |Sample mean (with forgetting) LI
Adaptation gain (0 to 1):
Jo.s8

¥ Make adapted table an output
[¥ Add adaptation enable/disable freset part

[~ Add celllock enable disable port

Action for out-of-range input |Ign0re LI

OK I Cancel Help | Apply |
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7 Click OK to close the Function Block Parameters dialog box.

The Simulink model now looks similar to the following figure.

E! enginetablel_data * ;lglﬁl

File Edit View Simulation Format Toolzs Help

DE&| fB2R|(E= 42+ 500 | [Nomal =

Experiments| Data

u

Enable Tout

Adaptive Lookup
Table (nD Stair-Fit)

Ready 100% |ode4s v




Building a Model Using Adaptive Lookup Table Blocks

8 Assign the input and output data to the engine model by connecting the
U and Y ports of the Experimental Data block to the u and y ports of the
Adaptive Lookup Table block, respectively.

E! enginetablel_data * ;lﬂlll

File Edit View Simulation Format Tools Help

OSE&E +B28 4|22 > =0 | [Nm =]

Experiments| Data

2.0 T(u)

u U

Enable Tout

Adaptive Lookup
Table (nD Stair-Fit)

Ready [100% [ |ode4s v

Tip To learn how to connect blocks in the Simulink model window, see
“Connecting Blocks in the Model Window” in the Simulink documentation.

9 Design a logic that enables or disables the adaptation process:

a Open the Simulink Library Browser by typing simulink at the MATLAB
prompt.

b In the Libraries area of the Simulink Library Browser window, select
Commonly Used Blocks.

¢ Drag the following blocks to the Simulink model window:
¢ Constant block
® Logical Operator block

To learn more about the blocks, see the Constant, and Logical Operator
block reference pages in the Simulink documentation.
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d In the Libraries area of the Simulink Library Browser window, select
Signal Routing, and drag the Manual Switch block to the Simulink
model window.

To learn more about the block, see the Manual Switch block reference
page in the Simulink documentation.

e Double-click the Logical Operator block to open the Function Block
Parameters: Logical Operator dialog box.

f Select NOT from the Operator drop-down list.

E! Function Block Parameters: Logical Operator x|

’rLogial Operator

Logical operators. For a single input, operators are applied across the input vector. For multiple
inputs, operators are applied across the inputs.

Main | Signal Attributes |

Operator: IAND |Z|
AND

Number of | 5o

[z nawo
MNOR

XOR.

Sample time (-1 for inherited):

[-1
,‘)- OK I Cancel Help | Apply |

g Click OK.

Icon shape
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h Connect the blocks to create a logic, as shown in the next figure.

E! enginetablel_data * ;IEIEI

File Edit View Simulation Format Tools Help

DEES| s =Rt |22 afoo |vom 5|8

Exparimental Data

u

h 4

Enable Tout

Ceonstant

M | Switch
enual Swit Adaptive Lookup

Table (nD Stair-Fit)

Logical
Operator

Ready [100% [ [ |FixedStepDiscrete 4

This logic outputs an initial value of 1 which enables the adaptation
process.

10 Add Display blocks to view the output of the adaptation process:

a In the Libraries area of the Simulink Library Browser window, select
Sinks, and drag the Display block to the Simulink model window.

b Drag another Display block from the Simulink Library Browser window
to the model window.

¢ Connect the Display blocks to the y and N ports of the Adaptive Lookup
Table block, as shown in the next figure.
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E! enginetablel_data * ;IEIEI

File Edit View Simulation Format Tools Help

DEES| s =Rt |22 afoo |vom 5|8

Experimental Dsta
2-0 Tiu)
v b Y ¥ 4’@
Display
¥ >y N
Display1
Enable Tout
Constant v
M | Switch
enual Swit Adaptive Lookup
Table (nD Stair-Fit)
Logical
Operator
Ready [100% [ [ |FixedstepDiscrete 4

During simulation, the Display blocks show the following:
e Display block — Shows the value of the current cell being adapted.
e Display1 block — Shows the number of the current cell being adapted.
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11 Open a preconfigured Simulink model that already contains a plot to
display the lookup table values as they adapt during simulation. To do so,
type the following model name at the MATLAB prompt:

enginetable1

The model opens, as shown in the next figure.

E!enginetablel_displav _I_I- a ﬁl

File Edit View Simulation Format Tools Help

D\@H@Hﬁﬁhﬁ@iﬂﬁ(ﬂb l'rrf Normal '”E

Exparimental Data Adsptive Table Outputs

Ul rmu

2-D T{u)

Cell Number

I"_\- = N @
Enable
] . [ o]
_"o—|Enable Tout Gragh Trigge
NOT N
Adaptive Lookup dapted Tabie

Table (nD Stair-Fit)

Y -y

Efficiency Surface

Ready [100% [ [ |ode4s 4

This model already contains a subsystem named Efficiency Surface that
generates a plot of the lookup table values as they adapt during simulation.

Tip You can also write your own MATLAB function to plot the adapted
table values during simulation.

You have now configured the adaptive lookup table parameters and built the
model for updating and viewing the adaptive lookup table values. You must
now simulate the model to start the adaptation, as described in “Adapting the
Lookup Table Values Using Time-Varying I/O Data” on page 10-16.
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Adapting the Lookup Table Values Using Time-Varying
1/0 Data

In this portion of the tutorial, you learn how to update the lookup table values
to adapt to the time-varying input and output values.

You must have already built the Simulink model, as described “Building a
Model Using Adaptive Lookup Table Blocks” on page 10-4. To open a saved
model that already contains the block parameters and display blocks, type
the following model name at the MATLAB prompt:

enginetable1

To perform the adaptation:

1 Connect a To Workspace Simulink block to export the adapted table values:

a Open the Simulink Library Browser, if it is not already open, by typing
simulink at the MATLAB prompt.

b In the Libraries area of the Simulink Library Browser window, select
Sinks, and drag the To Workspace block to the enginetable1 Simulink
model window.

To learn more about this block, see the To Workspace block reference
page in the Simulink documentation.
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Adapting the Lookup Table Values Using Time-Varying I/O Data

¢ Double-click the To Workspace block to open the Sink Block Parameters
dialog box, and type Tout in the Variable name field.

E! Sink Block Parameters: To Workspace x|
— To Workspac -

‘Write input ko specified array or struckture in MATLAE's main workspace, Data is
nat available until the simulation is stapped or paused.

—Parameter:

Wariahle name:
Limit daka points ta last:

I inf

Dedimation:
|1
Sample kime -1 For inherited):
|-1

Save Format: IStructurE LI

™ Log fixed-paint data as an fi abject

oK I Cancel Help | Apply |

d Click OK.
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e Connect the To Workspace block to the adaptive lookup table output
signal Tout, as shown in the next figure.

E!enginetahlel 2 M=l E

File Edit Wiew Simulation Format Tools Help

D SES| %=l (et |22 s | | He

Cata Adaptive Table Qutputs

20T
I —

Call Mumber

NN —

Graph Trigger

Enable Tout F
2dapted Table
Addaptive Lookup
Table (nCr Stair-Fit)
Efficieney Surface
To Wonspace
Ready [100% [ [ [FixedStepDiscrete v

2 In the Simulink model window, enter inf as the simulation time.

File Edit View Simulation Format Tools Help

DeEHES | fER |- 1|9 = Plﬁ INDrrnaI 'Il

The simulation time of infinity specifies that the adaptation process
continues as long as the input and output values of the engine change.
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3 In the Simulink model window, select Simulation > Start to start the
adaptation process.

A figure window opens that shows the volumetric efficiency of the engine as
a function of the intake manifold pressure and engine speed:

¢ The left plot shows the measured volumetric efficiency as a function of
intake manifold pressure and engine speed.

¢ The right plot shows the volumetric efficiency as it adapts with the
time-varying intake manifold pressure and engine speed.

=10l x|

File Edit View Insert Tools Deskiop Window Help
Dods k(R NPEL- 208 8D

Plant Sufface using Measured Data Plant Surface using Adaptive Lookup Table (Stair-fit)

o
@

Yolumetric Efficiency
Wolumnetric Efficiency

5000 5000
.

2000

Intake Manifold Pressure oo Engine Speed (rpm) Intake Manifold Pressure 0o

Ei Speed
kPa) kPa) hgine Speed (rprm)

During simulation, the lookup table values displayed on the right plot
adapt to the variations in the I/0 data. The left and the right plots resemble
each other after a few seconds, as shown in the next figure.
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iald
&

File Edit View Insert Tools Desktop Window Help

ODdds | [R809Rx - |2/0E 0D

Plant Surface using Measured Data Plant Surface using Adaptive Lookup Table (Stair-fit)

o o
=) o

(=1
S

Yolumetric Efficiency
Wolumnetric Efficiency

o
=)

5000 - ‘ 5000
o 4000
200 2000

Intake Manifold Pressure 0 o Engine Speed (pm) Intake Manifold Pressure (1)

kPa) (kPa) Engine Speed (rpm)

Tip During simulation, the Cell Number and Adaptive Table Outputs
blocks in the Simulink model display the cell number, and the adapted
lookup table value in the cell, respectively.

4 Examine that the left and the right plots match. This resemblance
indicates that the table values have adapted to the time-varying I/O data.

5 Pause the simulation by selecting Simulation > Pause.

This action also exports the adapted table values Tout to the MATLAB
workspace.

Note After you pause the simulation, the adapted table values are stored
in the Adaptive Lookup Table block.

6 After the table values adapt to the time-varying I/O data, you can continue
to use the Adaptive Lookup Table block as a static lookup table:

a In the Simulink model window, double-click the Manual Switch block.
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——
This action toggles the switch to > , and disables the adaptation.

b Select Simulation > Start to restart the simulation.

During simulation, the Adaptive Lookup Table block works like a
static lookup table, and continues to estimate the output values as the
input values change. You can see the current lookup table value in the
Adaptive Table Outputs block in the Simulink model window.

Note After you disable the adaptation, the Adaptive Lookup Table block
does not update the stored table values, and the figure that displays the
table values does not update.
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Examples

Use this list to find examples in the documentation.



A Examples

Getting Started
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Chapter 5, “Tutorial — Preparing Data for Parameter Estimation Using
the GUI”

Chapter 6, “Tutorial — Estimating Parameters from Measured Data Using
the GUI”

Chapter 7, “Tutorial — Optimizing Parameters to Meet Time-Domain
Requirements Using the GUI”

Chapter 8, “Tutorial — Optimizing Parameters to Meet Time-Domain
Requirements Using the Command Line”

Chapter 9, “Tutorial — Designing a PID Controller Using
Optimization-Based Tuning”

Chapter 10, “Tutorial — Modeling a System Using Adaptive Lookup Table”
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